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Introduction

Bluetooth® is an open specification for a cutting-edge technology that enables short-range
wireless connections between desktop and laptop computers, personal digital assistants,
cellular phones, printers, scanners, digital cameras and even home appliances — on a
globally available band (2.4GHz) for worldwide compatibility. In a nutshell, Bluetooth unplugs
your digital peripherals and makes cable clutter a thing of the past. Nowgou can connect
your PDA or PC to Bluetooth® enabled mobile phone with this Bluetooth® adapter.

You can access e-mail & Internet no matter where you are with just a little help from your
Bluetooth® mobile phone.

Plus, when you are back in the office, you can hook yourself up to your office network as
well as communicate with other Bluetooth®-enabled devices.

To use your Bluetooth Adapter with a Bluetooth-enabled device, you first need to install the
Bluetooth Adapter. You then need to set up the service for that device using the Bluetooth
Settings. Please see the appropriate sections in this User Guide for directions.




Chapter 1

Windows 98SE/ME

This Bluetooth Stack for Windows supports the following profiles. Please note that profiles
HSP, PAN, BIP, A2DP, AVRCP and GAVDP are supported by Windows XP and Windows
2000 only.

(a) Dial-Up Network (DUN)

(b) Fax profile (FAX)

(c) Local Access Profile (LAP)

(d) Serial Port Profile (SPP)

(e) Human Interface Devices (HID)

(f) Hard Copy Replacement Profile (HCRP)
(g) File Transfer Profile (FTP)

(h) Object Push Profile (OPP)

Windows 2000/XP
(a) Dial-Up Network (DUN)




(b) Fax profile (FAX)

(c) Local Access Profile (LAP)

(d) Serial Port Profile (SPP)

(e) Human Interface Devices (HID)

(f) Hard Copy Replacement Profile (HCRP)

(9) File Transfer Profile (FTP)

(h) Object Push Profile (OPP)

(i) Headset Profile (HSP)

(j) Personal Area Network (PAN)

(k) Basic Imaging Profile (BIP)

(I) Advanced Audio Distribution Profile (A2DP)

(m) A/V Remote Control Profile (AVRCP)

(n) Generic Audio Video Distribution Profile (GAVDP)

The Bluetooth Stack for Windows supports the following languages.

English

Danish

French




German
Italian
Japanese
Norwegian
Spanish
Swedish

The following languages are supported by Windows XP and Windows 2000 only.
Dutch

Korean

Simplified Chinese

Traditional Chinese

Russian

Finnish

Portuguese (Brazil)

The Bluetooth Stack for Windows supports the following operating systems.
Windows 98 Second Edition

Windows ME

Windows 2000 Professional (Service Pack 3 or above)

Windows XP Professional (Service Pack 1 or above)

Windows XP Home (Service Pack 1 or above)

Windows XP Tablet PC Edition

Windows XP Media Center Edition

(a) External Bluetooth drivers cannot be "signed drivers" to receive Microsoft WHQL logo.
Therefore, Microsoft's "Unsigned driver" warning messages may pop up during the software
installation, Bluetooth headset, mouse or keyboard setup. Please install the drivers and then
follow the on-screen instructions.




(b) On Swedish Windows XP, an error message (error code = 633) may be seen during dial-
up. Please update the operating system to Windows XP Service Pack 2 or refer to Microsoft
knowledge base #831717.

(c) Windows XP fast user switch is not supported. When switching to another user, the
Bluetooth Manager is not launched. Please log off before switching to another user.

(d) If "automatic FAX receiving" is enabled on Microsoft FAX manager, and if DUN, FAX, or
LAP profile icon is registered on Bluetooth Settings, and then Bluetooth's "resume from
standby" may take a couple of minutes to turn on.

(e) Windows 98 Second Edition: If the "Install New Modem" dialog pops up when setting up
a Bluetooth modem, mobile phone, or access point, please choose "Don't detect my modem;
| will select from a list". Otherwise, the system may freeze during the modem detection. If
the manual for your Bluetooth device does not specify a modem driver, then please select
"Standard 33600bps modem".

(f) Before connecting or disconnecting a Bluetooth headset, please exit any voice or sound-
related applications (e.g. Windows Messenger, Windows Media Player). The audio input
and output may not be switched properly if those applications are running. This same
precaution is important prior to system standby, hibernate or shutdown, and prior to turning
off or unplugging the primary Bluetooth device.




Chapter 2

Installing Bluetooth software for Windows

1.

Do not plug the Bluetooth device into your computer yet. You need to install the software
first.

Insert the installation CD into the CD drive. The CD should start automatically and the
Language Selection screen should appear. (If it does not, double-click the My
Computer icon on your desktop and then, in the My Computer window, double-click the
Zoom icon.)

In the Language Selection window, choose your language.

In the next window, select Installation Wizard then choose the name of your Bluetooth
device.

Follow the prompts to install the software. Note: Please accept the licensing agreement
when prompted.

Windows XP/2000 users only: If the Driver Signature Notice message box appears,
click OK.

When prompted, plug the Bluetooth device into your computer. (If you are using the USB
Adapter, you may find it helpful to connect the supplied USB cable between the USB
Adapter and the USB port.) Then click OK to continue the installation.

When the installation is complete, click Finish, then Yes. Your computer will shut down
and restart.

To use your Bluetooth USB Adapter or PC Card with another Bluetooth device, you need
to set up the service for that device using the Bluetooth Settings. Please see the
additional chapters in this Bluetooth USB Adapter User Guide for directions.




Chapter 3

Methods for registering new devices using the Bluetooth Utility shall now be described.
A Bluetooth mouse shall be connected and set up using [Bluetooth Settings] as an example.

[Bluetooth Settings] provides two set-up methods: "Express Mode" and "Custom Mode."

Express Mode

[Bluetooth Settings] will automatically detect and register services. If several services
(profiles) are supported by the device the service that has been set to the highest priority
shall be selected and registered.

Express Mode is normally recommended for device set-up.

Custom Mode

After having been detected, the services supported by the device are displayed as a list,
from which you can select the desired function(s).

Custom Mode must be used to set up a device if, for example, you wish to use a modem
station to send a fax (because in Express Mode, the DUN profile will be automatically
selected since it has a higher priority than the FAX profile).

The differences between setting up the same device (a Bluetooth mouse) using Express
Mode and Custom Mode are described on the following pages.

Express Mode Set-up

Starting Bluetooth Settings

. . Registerin
Starting Bluetooth Detecting . . B _g
. > . # Detecting services > settings
Settings Bluetooth devices . =,
information

1. Click [Start]>[All Programs]—>[Bluetooth]—>[Bluetooth Settings].
(Under Windows 2000, click [Start]—[Programs]—[Bluetooth]—[Bluetooth Settings].)

10



Note

- The same result can be achieved by right-clicking on the Bluetooth icon in the task
tray and selecting [Bluetooth Settings] from the menu that appears.

Bluetooth Settings

Add Mew Connection

Opkions

Help
Exik

[T 1029 pM

The [Bluetooth Settings] window below will appear when other devices have already
been registered.

e S N X

€3 Blugtooth

() Eorccsion

Please click the [New Connection] button to open the [Add New Connection Wizard] window.
If no devices have been registered yet, please proceed directly to "Detecting Bluetooth
Devices."

Detecting Bluetooth devices

. . Registeri
Sy Eleni P ATE] Detecting services Za:i::r sn :

Settings "| Bluetooth devices g g | Seing:
information

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] window
will appear.
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1. Switch the device power ON to make it connectable via Bluetooth.

2. Confirm that [Express Mode] has been selected in the [Add New Connection
Wizard (Welcome to the Add New Connection Wizard)] window, and click on the
[Next] button.

‘dd New Connection Wizard

Welcome to the Add New Connection Wizard

Thiz wizard regsters te connechion infomation of a remale
dewica.
Select lhe wizard mode.

(%) Exprezs Mods [Recommended
The most useful sarvice on a remote denice iz zet up,

() Custom Mode
An avalable senace on a remole device 15 seleched and set

Newt> | [ Cancal | |
Searching for Bluetooth devices will start.
Add Hew Connection Wizard
Searching for Bluetooth devices.
G neec i b Aol cvics

When the device has been detected, the name and address of the device will appear in the
[Add New Connection Wizard (Select Device)] window.

12



‘Add New Connection Wizard R
Select a device
Please choase e Blustooth desice you vazh bo use.
Bluetooth device addiess
Dievice kst
| Devics Manme Device Addiess IA::
L=
I
—=i
!V:!
[ <Back || Newt> | | Cancal |

Note

- If no device is found, please confirm that the device has been made connectable
via Bluetooth, and click on the [Update] button.

- Afurther device search will be performed.

Detecting services

Starting Bluetooth Detecting Reglh.terlng
. - . settings
Settings Bluetooth devices . .
information

1. Select the device name from [Device List] and click on the [Next] button.

Add New Connection Wizard '\__J

Select a device

Pleass choose the Blustooth device you wizh bo uss.

Bluetocth device addies:
Dewvice bzt

| Davica Hame Devica Addiess [ ]|
e R

[ <Back |l News | [ Cancel |
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Bluetooth device detection will commence.

Add Mew Connection Wizard

Pleaze wait while wizard searches for remote device services.

The local device iz searching for remole device services.

Note

A message will appear prompting you to prepare the device for connection.

If several services (profiles) are supported by the device, the service that has
been set to the highest priority shall be automatically selected and set up in
Express Mode. Please use Custom Mode if you wish to select desired services

manually.

When a service has been detected, a window prompting you to enter the
Bluetooth passkey (PIN code) may appear. Please enter the passkey and click on
the [OK] button. Typically, the PIN code is on the Bluetooth device.

Bluetooth Manager - Bluetaoth Security

Blustooth Passkey [PIN}
‘%J[l fFIef bharik, the deteult PIN wil be used )
Request Device
Elustooth Device Addiess:  00:07.61:00:B1:DE
Eluetooth Device Mams: BT-Mousze.1

ook ] [Lcencel ]

If you have not entered your Bluetooth passkey after a certain amount of time has
passed, the connection process will be cancelled for security reasons. Please

perform the passkey entry process again.

2. Click on the [OK] button.

14




Blustooth Settings

-
J(J Prepare to connect bo the remota HID device, then dick O,

Note

- When the settings information has been registered, a window prompting you to
enter your Bluetooth passkey (PIN code) may appear. Please enter your passkey
and click on the [OK] button. Typically, the PIN code is on the Bluetooth device.

Bluetooth Manager - Bluetooth Security

Blustooth Passkey [FIN}
ﬁ {IF ledt Bharik, the defaull FIN wil be used )
Request Device
Elustooth Device Adddiezs:  00:0761:001:81:DE
Eluetooth Device Mams: BT-Mousze.1

Lok | [.cancel. ]

- If you have not entered your Bluetooth passkey after a certain amount of time has
passed, the connection process will be cancelled for security reasons. Please
perform the passkey entry process again.

The [Add New Connection Wizard (Connection Name Setup)] window will appear if a
service has been properly detected.

. Select the type and name of the icon to be displayed once the device has been
registered, and click on the [Next] button.

15



#Add New Connection Wizard I._._JI

Enter a name and select an icon.

Setup the connechon name and icon.

Seltng infomabion
I:u_':udim Name:
BT:-Mouze-1
lcon
6 | Change lcong... ]
[l Cirste a shortcut o the deskiop

| <Back || News | | Cancal |

Note

- If you wish to change the icon, please click on the [Change Icon] button and select
your preferred icon from the list that appears.

Bay=0ns

myE o=@
s @d(DU
sar @ [ w9

ERSH T |

ok J[ cancet |

Registering settings information

Starting Bluetooth Detecting
Settings "| Bluetooth devices

Detecting services

16



The [Add New Connection Wizard (Completing the Add New Connection Wizard)] window
will appear.

1. Click on the [Finish] button

Regshation of connechon infoimation complete.

| <Back || Fish | | Cancal ]

The [Bluetooth Settings] window will appear.
The icons of the registered devices will appear, and the devices will be ready to use.

& Blastaoth Settings M)
Bhetaoth  View Help

£} Bluetooth

e (@ Detai..| |3 pelete | |

17



Custom Mode Set-up
Starting Bluetooth Settings

. Registeri
Dzl Detecting services ZE;;: . : y
Bluetooth devices g . g‘
information

1. Click [Start]>[All Programs]—>[Bluetooth]>[Bluetooth Settings].
(Under Windows 2000, click [Start]—[Programs]—[Bluetooth]—[Bluetooth Settings].)

k.

Note

- The same result can be achieved by right-clicking on the Bluetooth icon in the task
tray and selecting [Bluetooth Settings] from the menu that appears.

Bluetooth Settings

Add Mew Connection
Device Properties
Options

Help
Exit

10:29 PM

L2
The [Bluetooth Settings] window below will appear when other devices have already
been registered.

! Bluetooth Settings (=% |
Bletooth Wiew  Help

£3 Bluetooth

(@ oo ] [ oes )

18



Please click the [New Connection] button to open the [Add New Connection Wizard]
window. If no devices have been registered yet, please proceed directly to "Detecting
Bluetooth Devices."

Detecting Bluetooth devices

. ) Registeri
Starting Bluetooth 2 2 Detecting services Za:i::r Sn ‘

Settings "| Bluetooth devices g g o e
information

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] window
will appear.

1. Switch the device power ON to make it connectable via Bluetooth.

2. Confirm that [Custom Mode] has been selected in the [Add New Connection
Wizard (Welcome to the Add New Connection Wizard)] window, and click on the
[Next] button.

Add Hew Connection Wizard

Welcome to the Add Hew Connection Wizard

Thiz vazard regsters the connechion infomation of a remole
devica,
Select the wizand mode.

() Express Moda [Recommended)
Thie miost uzeful zervice on a remobe device iz set up,

(%] Custom Mode

#An avalable serice on a remole device 15 selected and oot
up.

[ Nests | [ Cancal |

Searching for Bluetooth devices will start.

19



Add Hew Connection Wizard

Searching for Bluetooth devices.

Searching fos Bluetooth devices.

When the device has been detected, the name and address of the device will appear in
the [Add New Connection Wizard (Select Device)] window.

Pleass choose the Blustooth device you waizh bo use.

Blustooth device addiess

Device lisk
E Device Hame Device Addiess i"'":

| B Hegse COOTAETSES ]

[» ]

[ <Back || Mewts | [ Cancel |

Note

- If no device is found, please confirm that the device has been made connectable via
Bluetooth, and click on the [Update] button. A further device search will be
performed.

20



Detecting services

Starting Bluetooth Detecting REglh.tmng
. > . settings
Settings Bluctooth devices . .
information

1. Select the device name from [Device List] and click on the [Next] button.

Select a device

Please choose the Blustooth device you wazh bo use.

Blustooth device addiess
Device lisk

[cBock J| pew> | [ Comcdl ]

Bluetooth device detection will commence.

21



Add New Connection Wizard

Pleaze wait while wizard searches for remote device zervices.

The local device iz searching for remobe device senvices.

Note

- When a service has been detected, a window prompting you to enter the
Bluetooth passkey (PIN code) may appear. Please enter the passkey and click
on the [OK] button. Typically, the PIN code is on the Bluetooth device.

Bluetooth Manager - Bluetaoth Security

Bluetooth Passkey [PIN]
‘%J[l {f left bk, the detout PIN wil be used )
Request Device
Elustooth Device Addiess:  00:07.61:00:B1:DE
Eluetooth Dewice Mams: BT-Mousze-1

ook ] [Lcencel ]

- If you have not entered your Bluetooth passkey after a certain amount of time
has passed, the connection process will be cancelled for security reasons.
Please perform the passkey entry process again.

- If you try to register a device that has already been registered, the following
message will appear, and you will not be able to proceed with further operation.
Please click on the [OK] button to close the message.

22



; IE This HID devica Is slraady registarad. |

The services supported by the device will be displayed.
2. Select the desired service and click on the [Next] button.

Add MHew Connection Wizard

Select a sevice.

Please chooze the senice o uss.
Service selaction

Senvice Class Sefvice Mame
| S Human Inbertace Device Cordless Presenter

[l ] | i

[ cBack J[_New> ] [ Concal ] |

Note

- When a device supports several services
If the device supports several services, you can use Custom Mode to manually
select the services (profiles) you wish to use from the list that appears under
[Select Services].

Example: List of wireless modem station services

Sernce selachon

Seavica Clase Seavice M ams
[l Digtup Metwo... Dislup netwaiking
g:j'Fm ; Fax
& Senal Por Serial Poat

23



If Express Mode is used to perform the set-up, the highest-priority service in the
device will be automatically selected and configured.

3. Click on the [OK] button.

Bluetooth Settings

» 1
J(} Prepare to connedk to the remate HID devica, then dick Ci.

Note

- When the settings information has been registered, a window prompting you to
enter your Bluetooth passkey (PIN code) may appear. Please enter your passkey
and click on the [OK] button. Typically, the PIN code is on the Bluetooth device.

Bluetooth Manager - Bluetooth Security

Blustooth Passkey [FIN}
ﬁ {IF ledt Bharik, the defaull FIN wil be used )
Request Device
Elustooth Device Adddiezs:  00:0761:001:81:DE
Eluetooth Device Mams: BT-Mousze.1

Lok | [.cancel. ]

- If you have not entered your Bluetooth passkey after a certain amount of time has
passed, the connection process will be cancelled for security reasons. Please
perform the passkey entry process again.

The [Add New Connection Wizard (Connection Name Setup)] window will appear if a
service has been properly detected.

4. Select the type and name of the icon to be displayed once the device has been
registered, and click on the [Next] button.

24



‘Add New Connection Wizard '___J

Enter a name and select an icon.

Setup the connechon name and icon.

Sethng infommation

Connection Name:
BT:-Mouze-1
lcon
6 | Change lcong... ]
[ Create a shotcad on the deskiop

| <Back || News | | Cancal |

Note

- If you wish to change the icon, please click on the [Change Icon] button and select
your preferred icon from the list that appears.

B sy % |

Eei=0ns
mEEOSLE
CeF-= C IO
LN RA,
ERSH
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Registering settings information

Starting Bluetooth Detecting . . Regi tering
Settings "| Bluetooth devices g | R | settng
information

The [Add New Connection Wizard (Completing the Add New Connection Wizard)]
window will appear.

1. Click on the [Finish] button

Add New Connection Wizard

Completing the Add New Connection Wizard

Regshation of connechon infomation complete.

[ <Back || Fiish | | Cancal ]

The [Bluetooth Settings] window will appear.
The icons of the registered devices will appear, and the devices will be ready to use.

26
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Chapter 4

Connecting to the internet

Connecting to the internet using a modem station
Setting up the modem station
1. Turn on the wireless modem station.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].
Bluetooth Settings

Add Mew Conmection
Dienvice Properties

Pawer OFF

Ciplions ]

Help
Exit

- ¥ Qs

Note
- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings], and
then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.

28



r'fldd Hew Connection Wizard

Thit wizard will create the zettingz for Blustooth device connection.

Pleass ensure pour Blustooth devices are on and zef to
dizcoverable.

(%) Expuess Mods [Recommended]

() Cuztom Mode
Thiz alloves pou to set the detals for the conmechon.

ooy || ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

ﬂldd Hew Connection Wizard

Searching for Bluetooth devices.

Seaiching for Blustoath devices. |

4. Select the device name of the wireless modem station from [Device List], and
then click on the [Next] button.

29



T Tt Wiard

Select a device

Please chooze the Bhastooth device you wizh bo use.

Blustooth device

Device Mame
| B [[BT Modam
| I PG-1
| B PocketPG
| £ Blstooth Prister

i [ £ Back ][_ﬂaan ][ Cancal ]'

The [Add New Connection Wizard (Searching for Services)] window will appear.

Pleaze wait while the wizard connect: to a remote device.

The local device iz connecling la the iemaote device
ZAMVICE,
Please wail.

Once a service has been detected successfully, connection to the device and COM
port creation will be performed automatically, after which the [Add New Connection
Wizard (Modem Settings)] window will appear.

30



5. If you are connecting to a wireless modem station for the first time, enter the
passkey for the modem station under [Bluetooth Passkey (PIN code)], and then
click on the [OK] button. Typically, the PIN code is on the Bluetooth device.

Bluetooth Manager - Bluetooth Security

Blustooth Passkey (FIN} [T
?Sﬁg {1 lett blarik. the default PIM wil be used)
Request Device

Elustooth Device Addiess,  D0:0000:00:00;00
Blustooth Device Mame; TOSHIES BT Modem

[ ok ][ cence ]

Once the program has finished searching for the devices, the [Add New Connection
Wizard (Device Selection)] window will appear.

6. Click on the [Next] button.

‘Add New Connection Wizard

Advanced Modem Settings

Fleasze chok the "dvanced Modem Settings”” bution
fioe further configuration options (e.g. for HSCS5D oo
GPRS] or chick "Hexl™ lo continues.

| Schvanced Modem Setlings... |

E + Back 3[ Meut » ]l_ Camcal ]

Certain modems require you to configure initialization commands separately.
Please click on the [Additional initialization Command Settings] button, enter the
initialization commands in the following window, and then click on the [OK] button.

Note

- Please refer to the modem or mobile phone instruction manual for further detail or
mobile phone instruction manual for further details on initialization commands.
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"hdvam:td Modem Settings ﬁ

‘fios can anter special AT-Commands for the metalled modem. This
may be necessany fod some connections, &.g. GFRS and HSCSD

| Flease check the homepage of your provider and your mobile phane
| wendor lo get the comect setings. These selimgs wall vary betbwesn
differant mobde phoese vendors and providers.

Examples:

GFRS: +CGEOCONT =1."IP","apn provider de™
HSCS0: +CBST=81,001+CHSN-4.0.0.0

| Estrainktizlization commands:

ok J [ concel |

7. Enter the connection name (optional), telephone number (of your provider's
access point), user name and password (as issued by your provider), and then
click on the [Finish] button.

Create dial-up connection

Please ghve the dial-up connechon a name, belephane
number, and ¥ requited, a wser name and passwond

Dialup connection name: | andan A

| Telephene number, 0207 957 6543

Lizer name:; tgaadys

5 Pagsmand: seEsERRE e
Confim password: sensssnnse
[#] Set as Diedaud Dialup

| <Back || Finsh | | Cancal ]

Important

The sample entries shown in the window are provided solely for purpose of
explanation. Please use your own telephone number, ID and password according
to the arrangement with your provider.

The settings will be registered, and an icon will appear in the [Bluetooth Settings]
window.
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London &

Connecting to the Internet
1. Start your browser, e-mail application or other application

Important

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application).

2. Enter the URL of the Web page you wish to display and then press the [Enter]
key, or use the e-mail tool to send/receive items or perform other activities.

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

Dial-up Connection
M- Select the service you want ho connexct
“;’d ba, and then erter pour user namse and
pazswoid,
Copnecitc: | London A ™
Llzer name: rgocdyd9
Passweed TTIll Lttt

[#] Save pazsword
[ Connect automaticaly

| Cornect | | Setings.. | | Wock Otfine |

Important

A connection will be automatically established with the modem station if COM Auto
Connect is available. If COM Auto Connect is not available, please manually
connect to the modem station.

The following message will appear once you have connected to the Internet.
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4

1.

i) London A is now connected |

Spead: 115.2 Ebps

2% %P uwQO | we

. End the connection

The window below will appear if you double-click on the:gicon in the task bar.

i~ London A Status
| | Gemeral | Dielails |
. Conrueclion
Stalus: Cormeched
Diuration; 00006
Speed 1152 Kbps
Adnaby
Sent — 1 — Recsived
Bytez: FA YT 532
Compeession: 0x ox
Erors 1] 3
Prapesties | l Dizcorinect J
Close '

Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on the:gicon, and then click on [Disconnect].

Ciesconnect
Status

Cpan Network Connections

JAE

Note

- You can start an application to make an automatic connection to the Internet, but
you can also make a manual connection using the connection destination icon.
The procedure is described below.

From the [Bluetooth Settings] window, right-click on the connection destination
icon, and then click on [Connect] from the menu that appears.
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£3 Biuetooth

A window indicating that the connection is being established will appear.

@ Bluetooth Settings [= _'va

If the connection has been established successfully, the connection icon and task tray
will appear as shown below.

i/ London A is now connected |

Spead: 115.2 Kbps
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You will be able to browse Web pages using your browser and send and receive e-
mail.

Important

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application).

. End the connection
Right-click on the icon, and then click [Disconnect] to end the connection.

[l'-d Bluetooth Settings : Fa \[E'.]

Bheetooth  View Halp

Delete:
Detal. ..

Create Shorteut on Deskiop
'———  Rename
Change Tcons. ..

@ = o um_..l..] 7§ Dalata
2 Connedon

The following message will appear. Click on the [Yes] button.

‘Bluetooth Settings

b d Londaon & cannot be used If disconnected.
-Q-/ Are wou sure you want Bo disconnect?

[RENRTTIIIN || pu—"rsr——

When the icon appears as shown below, the connection will have ended.

London &
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Connecting to the internet using a mobile telephone

Important

- In order to connect to the Internet, you must have already signed up with a
provider and obtained a connection ID and password. Please ensure you have
confirmed the ID, password and telephone number of your provider's access
point before you begin the set-up process.

- A Bluetooth passkey (PIN code) is required for you to connect to the mobile
telephone. Please make a note of your Bluetooth passkey before you start the
set-up process. Typically, the PIN code is on the Bluetooth device.

Configuring a mobile telephone for use a modem
1. Turn on the mobile phone, and set it to be connectable via Bluetooth.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].
Bluetooth Settings

Add Mew Conmection
Dienvice Properties

Pawer OFF

Ciplions ]

Hedp
Exit

. T o [T

Note
- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings], and
then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.
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r'fldd Hew Connection Wizard

Thit wizard will create the zettingz for Blustooth device connection.

Pleass ensure pour Blustooth devices are on and zef to
dizcoverable.

(%) Expuess Mods [Recommended]

() Cuztom Mode
Thiz alloves pou to set the detals for the conmechon.

ooy || ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

ﬂldd Hew Connection Wizard

Searching for Bluetooth devices.

Seaiching for Blustoath devices. |

4. Select the device name of the mobile telephone from [Device List], and then
click on the [Next] button.
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T Tt Wiard

Select a device

Please chooze the Bhastooth device you wizh bo use.

Blustooth device

Device Mame
| B [[BT Modam
| I PG-1
| B PocketPG
| £ Blstooth Prister

i [ £ Back ][_ﬂaan ][ Cancal ]'

The [Add New Connection Wizard (Searching for Services)] window will appear.

Pleaze wait while the wizard connect: to a remote device.

The local device iz connecling la the iemaote device
ZAMVICE,
Please wail.

Once a service has been detected successfully, connection to the device and COM
port creation will be performed automatically, after which the [Add New Connection
Wizard (Modem Settings)] window will appear.
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5. If you are connecting to a mobile telephone for the first time, enter the passkey
for the wireless modem station under [Bluetooth Passkey (PIN code)], and then
click on the [OK] button. Typically, the PIN code is on the Bluetooth device.

Bluetooth Manager - Bluetooth Security

Blustooth Passkey (FIN} REREEEE
?Sﬁg {1 lett blarik. the default PIM wil be used)
Request Device
Elustooth Devics Addiess:  00:00:00:00:00:00
Blustooth Device Mame; TOSHIES BT Modem

[ ok ][ cence ]

Once the program has finished searching for the devices, the [Add New Connection
Wizard (Device Selection)] window will appear.

6. Click on the [Next] button.
‘Add New Connection Wizard

Advanced Modem Settings

Fleasze chok the "dvanced Modem Settings”” bution
fioe further configuration options (e.g. for HSCS5D oo
GPRS] or chick "Hexl™ lo continues.

| Schvanced Modem Setlings... |

E {ﬁadﬁ ;[ Meut » ]l_ Cancal ]

Certain modems require you to configure initialization commands separately.
Please click on the [Additional initialization Command Settings] button, enter the
initialization commands in the following window, and then click on the [OK] button.

40



-

"hdvam:td Modem Settings ﬁ

‘fios can anter special AT-Commands for the metalled modem. This
may be necessany fod some connections, &.g. GFRS and HSCSD

| Flease check the homepage of your provider and your mobile phane
| wendor lo get the comect setings. These selimgs wall vary betbwesn
differant mobde phoese vendors and providers.

Examples:

GFRS: +CGEOCONT =1."IP","apn provider de™
HSCS0: +CBST=81,001+CHSN-4.0.0.0

| Estrainktizlization commands:

ok J [ concel |

7. Enter the connection name (optional), telephone number (of your provider's
access point), user name and password (as issued by your provider), and then
click on the [Finish] button.

Create dial-up connection

Please ghve the dial-up connechon a name, belephane
number, and ¥ requited, a wser name and passwond

Dialup connection name: | andan A

| Telephene number, 0207 957 6543

Lizer name:; tgaadys

5 Pagsmand: seEsERRE e
Confim password: sensssnnse
[#] Set as Diedaud Dialup

| <Back || Finsh | | Cancal ]

Important

The sample entries shown in the window are provided solely for purpose of
explanation. Please use your own telephone number, ID and password according
to the arrangement with your provider.

The settings will be registered, and an icon will appear in the [Bluetooth Settings]
window.
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London &

Connecting to the Internet
1. Start your browser, e-mail application or other application

Important

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application).

2. Enter the URL of the Web page you wish to display and then press the [Enter]
key, or use the e-mail tool to send/receive items or perform other activities.

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

Dial-up Connection
M- Select the service you want ho connexct
“;’d ba, and then erter pour user namse and
pazswoid,
Copnecitc: | London A ™
Llzer name: rgocdyd9
Passweed TTIll Lttt

[#] Save pazsword
[ Connect automaticaly

| Cornect | | Setings.. | | Wock Otfine |

Important

A connection will be automatically established with the modem station if COM Auto
Connect is available. If COM Auto Connect is not available, please manually
connect to the mobile telephone .

The following message will appear once you have connected to the Internet.

42



4

1.

i) London A is now connected |

Spead: 115.2 Ebps

2% %P uwQO | we

. End the connection

The window below will appear if you double-click on the:gicon in the task bar.

i~ London A Status
| | Gemeral | Dielails |
. Conrueclion
Stalus: Cormeched
Diuration; 00006
Speed 1152 Kbps
Adnaby
Sent — 1 — Recsived
Bytez: FA YT 532
Compeession: 0x ox
Erors 1] 3
Prapesties | l Dizcorinect J
Close '

Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on the:gicon, and then click on [Disconnect].

Ciesconnect
Status

Cpan Network Connections

JAE

Note

- You can start an application to make an automatic connection to the Internet, but
you can also make a manual connection using the connection destination icon.
The procedure is described below.

From the [Bluetooth Settings] window, right-click on the connection destination
icon, and then click on [Connect] from the menu that appears.
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£3 Biuetooth

A window indicating that the connection is being established will appear.

@ Bluetooth Settings [= _'va

If the connection has been established successfully, the connection icon and task tray
will appear as shown below.

i/ London A is now connected |

Spead: 115.2 Kbps
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You will be able to browse Web pages using your browser and send and receive e-
mail.

Important

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application).

. End the connection
Right-click on the icon, and then click [Disconnect] to end the connection.

[l'-d Bluetooth Settings : Fa \[E'.]

Bheetooth  View Halp

Delete:
Detal. ..

Create Shorteut on Deskiop
'———  Rename
Change Tcons. ..

@ = o um_..l..] 7§ Dalata
2 Connedon

The following message will appear. Click on the [Yes] button.

‘Bluetooth Settings

b d Londaon & cannot be used If disconnected.
-Q-/ Are wou sure you want Bo disconnect?

[RENRTTIIIN || pu—"rsr——

When the icon appears as shown below, the connection will have ended.

London &
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Connecting to a network|[LAN]

Connecting to a LAN using an access point[LAP]
Setting up the access point
Important

- The access point must have been started and a normal connection already
established to the network before the access point is set up. Please refer to the
access point instruction manual for information on how to set up the access
point.

- A Bluetooth passkey (PIN code) is required for you to connect to the access
point. Please make a note of your Bluetooth passkey before you start the set-up
process. Typically, the PIN code is on the Bluetooth device.

1. Turn on the access point, and confirm that a connection has been established
with the network.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add Mew Conmection
Dienvice Properties

Pawer OFF

Ciplions ]

Hedp
Exit

. T o [T

Note

- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings], and
then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.
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r'fldd Hew Connection Wizard

Thit wizard will create the zettingz for Blustooth device connection.

Pleass ensure pour Blustooth devices are on and zef to
dizcoverable.

(%) Expuess Mods [Recommended]

() Cuztom Mode
Thiz alloves pou to set the detals for the conmechon.

ooy || ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

ﬂldd Hew Connection Wizard

Searching for Bluetooth devices.

Seaiching for Blustoath devices. |

4. Select the device name of the access point from [Device List], and then click on
the [Next] button.
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Add New Connection Wizard

Select a device

Please chooze the Bhsetooth device you wash bo use.

Blugiooth device addies:

Device list
Dewica Hams Device Addiess s
B ﬂ_l:
| PCA 0003 7406 BAES
[¥]

[ <Back || New> | [ Cancal ]

You will be asked for the Bluetooth passkey in the window that appears.

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the
[OK] button.

Bluetooth Passkey (FIN} =
ﬁ% {Fleft blank, the defoult PIN wil be used )
Request Device
Elustooth Device Addiess:  0003:748:02:C287
Blustooth Deavice Mame: BT-4P-1

i R

Service detection and COM port creation will be performed automatically.
The [Add New Connection Wizard (Create Connection Destination)] window will
appear.

6. Enter the connection name, user name and password, then click on the
[Next] button.
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‘dd New Connection Wizard

Create a connection setting

Pleasze give the conmeclion a nane, and if required, a user
name and passwond

Connechion name: Diect Carneclion
Uzar nanme:
Pazsword:

Confiom password:

[ <Back || Mew> | [ Cancal ]

Note

- The user name and password are entered here to allow you to connect to the
access point.

The [Add New Connection Wizard (Confirm Dial-up Settings)] window will appear.
7. Click on the [Confirm Settings] button.

Add Hew Connection Wizard

Pleaze confitm a dial-up setting

I [Mewar dial a connection] has bean salected in the |
Intemet propesties, connections made sccording 1o the I
COM Autoconnect settings will ot function propeark:.

Fleass press the butlon below to conlimm dial-up sellings,

Confim zathings... ]

liocBack b Ned> .| | Cancel |
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8. Configure the connection method, and then click on the [OK] button.
Set the connection destination used for the LAN connection set up in (6) above as
the default connection destination, and then select "Always dial my default
connection."

Internet Properties E‘

| | General | Secuily | Privacy  Contert| Connections | Programs  Advanced | |
ﬁ_ To set up an Inbermet connection, chck .
W] cenp ehup..,

Dralup and Virual Prvate Mefwork settings

&8 Direct Connection [Defaul]

Chooge Sattings if you need to configure & procoy Setlings...
server for a connechion.

() Neves dial a conneclion

() Dial whernever a network connection i not prazert
@){Blways dral my default connection

Currant Direct Connection

Local drea Metwork [L&H) setlings

LAN Settings do not apply to dishup connedtions. | Lam ge.u"gg___,ll
Chicose Sattings above For dial-up settings,

[ ok [ conce ][ ook ]

9. Click on the [Next] button.
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Add New Connection Wizard

Pleaze confitm a dial-up setting

I [Mewver dial a connection] has been selected in the
Intemet propesties, connections made according lo the
COM Autoconnect setlings vl not lunclion properks.
Fleass press the button below to confim dial-up setlings,

Confim zettings... ]

[ <Back Jf Mew> | | Cancal ]I

10. Enter the type and name of the icon displayed after registration, and then click
on the [Next] button.
Please click on the [Next] button if you are satisfied with the settings.

T T e e e S 3

Enter a name and zelect an icon.

Setup the connechon name and icon.

Settng infomation
Connechion Mame:
BT-AP-1(152 163.100.117] [Dvect Connection]

% | Change lcons... |

[] Cieate & ghaitewt an the desklop

FEPT T ey | | re—" ]

11. Click on the [Finish] button.

The access point icon will be registered in the [Bluetooth Settings] window.
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o
BT-AP-1(192,1
&6, 100,11}
[Direct

Connection]
Connecting to a LAN(LAP)

1. Right-click on the connection icon in the [Bluetooth Settings] window, and then
click on [Connect].

L/ Bluetooth Settings =
Bhestooth  View Hzlp

€3 Bluetooth

Delata

Create Shorbout on Deskiop
L Renams
Thange loons. ..

e

2. Confirm that "Direct connection" has been selected under [Connection
Destination], and then click on the [Connect] button

tlinl-up Connection .

- Select the service pou wank bo connect
B 1o, and ther enter pour user name and

pazsword,
Copnecttec | Direct Comnection v
Llzer name:
Passwced
[] Save pazswond

Connect fsg‘m.. j Cancal | |
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A connection will be initiated.

Note

This is an example of what happens when you use "Direct connection" as a
connection name under "Connect to access point." If a name different from the
connection name is used, that name will appear under [Connection Destination].

Please simply click on [Settings] if no user name or password have been entered
(i.e., if those fields have been left blank)

Please change the connection destination if a different connection name (for a
dial-up connection) appears in [Connection Destination].

Direct Conmechion b

Direct Connection |
Lomedion &

Once you connect to the network, Internet Explorer will start automatically, and you
will be able to exchange data with other computers on the network.

Note
Please follow the procedure below if you need to set up a proxy server to connect

to the Internet (the following procedure is not necessary if the PC you are going to
use has already been set up as a proxy server).
1. Select [Internet Options...] from the [Tools] menu in Internet Explorer.

The [Internet Options] window will appear.

2. Click on the [Connections] tab, and then click on the [Settings...] button.
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‘Internet Properties

 General | Secuily | Privacy | Cortert| Connectons | Programs | Advanced |

= To satlup an Inkermat connection, chck
Dralup and Virual Prvate Metwork setings
Direct Connection [Diefauk] [ agd.,
Lordon & ‘
Hemove

Chooge Sattings if you need to configure & prooy
server for a connechion.

() Heves dial a connection

() Diial whenever a retwork connection i not prazert
(3 Alwiays dhal my defeull connection

Currant Direct Connection

Local duea Metwork [L&N ] setlings

LAN Settings da not spply to dis-up connedtions. Seltings...
Chicose Sattings above Foe dial-up settings, LA

Lok J[ cence J|

]

g

3. Enter the IP address and port number of the proxy server under [Proxy
Server], and then click on the [OK] button.

= =

use of marual settings, dissble sutomatic canfigiration,
[ Bustomatically datect settings
[ Use automatic configuration soript

Addess

| Prooy sarver

Llcsaa progy server For Bhis connection {These sattings will ot
apply bo obher connactions),

Address: | 172.17.40.100  Port |80 |

[T IBypass proxy server for local addresses

Dial-up settings
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Connecting to a LAN using an access point[PAN]
Setting up the access point
Important

- The access point must have been started and a normal connection already
established to the network before the access point is set up. Please refer to the
access point instruction manual for information on how to set up the access point.

- A Bluetooth passkey (PIN code) is required for you to connect to the access point.
Please make a note of your Bluetooth passkey before you start the set-up
process. Typically, the PIN code is on the Bluetooth device.

1. Turn on the access point, and confirm that a connection has been established with
the network.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New

Connection].
Bluetooth Settings
Add Mew Conmection
Dienvice Properties
Pawer OFF
Ciplions ]
Hedp
Exit
. T o [T
Note

- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings],
and then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next] button.
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r'fldd Hew Connection Wizard

Thit wizard will create the zettingz for Blustooth device connection.

Pleass ensure pour Blustooth devices are on and zef to
dizcoverable.

(%) Expuess Mods [Recommended]

() Cuztom Mode
Thiz alloves pou to set the detals for the conmechon.

ooy || ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

ﬂldd Hew Connection Wizard

Searching for Bluetooth devices.

Seaiching for Blustoath devices. |

4. Select the device name of the access point from [Device List], and then click on the
[Next] button.
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Add Mew Connection Wizard

Select a device

Pleass chooze the Blustooth device you wizh bo use.

Bluetooth device addiess

Dievice list
Dewice Mame Device Addiess [ ]

[BT-AP1 OOA0ECECECET ]

[ <pack | News | [ coreel ]

You will be asked for the Bluetooth passkey in the window that appears.

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the [OK]
button.

Bluetooth Manager - Bluetooth Security

Blustooth Passkey (FIN}
ﬁ {1 left blank, the default PIN wil be used )
Request Device
Elustooth Devies Addiess:  00:40:8C:5C:BC.E7
Blustooth Deavice Mame: BT.AP.1  [192163.100.21)

o || =

Service detection and COM port creation will be performed automatically.
The [Add New Connection Wizard (Connection Name Settings)] window will appear.

6. Enter the type and name of the icon displayed after registration, and then click on
the [Next] button. Please click on the [Next] button if you are satisfied with the
settings.
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Add New Connection Wizard

Enter a name and zelect an icon.

Setup the conmection name and icon.

Selbing infomation
Connechion Mame:

BT-APA (192168.100.21)

% | Change leons...

[ ] Cieate & shatteut on the deskiop

[ <Back || Mew> | [ Cancal |

The [Add New Connection Wizard (Completing the Add New Connection Wizard)]
window will appear.

7. Click on the [Finish] button.
The access point icon will be registered in the [Bluetooth Settings] window.

-]
HE
L BT-AP-1
1921680172):

This will complete the access point set-up process.

Connecting to a LAN(PAN)

1. Right-click on the connection icon in the [Bluetooth Settings] window, and then
click on [Connect].

58



L Bluetooth Settings =
Bluetooth  View Help

€3 Bluetooth

Create Shorbout on Deskiop
L | Renams

(Thange lcons. ..

L&)
' Connection

2. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the
[OK] button.

Bluetooth Manager - Bluetooth Security

Bluetooth Passkey [PIN}
% [IF ledt bharik., the default PIN wil be used )
Request Device
Elustooth Devies Addiess:  00:40:8C:5C:BC.E7
Elustooth Device Mare: BT.AP.1  [192163.100.21)

T T

A connection will be initiated.

Note
Please follow the procedure below if you need to set up a proxy server to connect

to the Internet (the following procedure is not necessary if the PC you are going to
use has already been set up as a proxy server).
1. Select [Internet Options...] from the [Tools] menu in Internet Explorer.

The [Internet Options] window will appear.

2. Click on the [Connections] tab, and then click on the [Settings...] button.
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Internet Properties 2

| Gonsa | Secutp| Pisecy | Coment] Cormectons | Prograns | Adanced]

ﬁ' + Toset up an Intermet connection, chk
=] senp.

Dralup and Virual Prvate Metwork setings

[ &8 Direct Connection [Defauk] |
| &5 Londan & [
| T

Choose Sattings if you need to configure & proocy ehlirgs...
sarver for a connectian. 2

() Heves dial a connection

() Diial whenever a retwork connection i not prazert
() Blwais dhal i defaull connection

Current Direct Connection

Sekup..,

Local duea Metwork [L&N ] setlings

LAN Settings da not spply to dis-up connedtions. S i
Chicose Sattings above Foe dial-up settings, Lo ging

Lok J[ concs |[ aoop |

3. Enter the IP address and port number of the proxy server under [Proxy
Server], and then click on the [OK] button.

e

Automatic configuration

Automatic corfiguration may override manual settings. To ensure the
use of marual settings, disable autcmatic configuration,

[] twstomatically detect settings
[ ] Use automatic configuration soript

Proxy sarver

USB a proxy server for your LAN (These settings wil not apphy o
dial-up or ¥PN conmectons).

Address: 172, 1740, 100 Park: | 80

[ ] Bypass proooy server for local addrasses

Sending files

You can send and receive files other than business card data with a Bluetooth-enabled PC
or PDA. Use "File transfer" in the Bluetooth Information Exchanger to exchange files.

Note
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- The same operations will be valid as long as the PC and PDA support the FTP
profile

- "File transfer" cannot be used to send or receive business card data. Please
instead use "Object Push" to perform these activities.

Exchanging files with a PC or PDA
Sending files to a PC or PDA
1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

{{{-ﬂ‘&
ol

Eluetooth
Information
Exchanger

Note

Alternatively, opening Explorer and clicking on the Bluetooth Information Exchanger
folder will produce the same result.

L] Bluetooth Information Exchanger
Efe  Wiew Favoribes  Tools  Buetooth Help

@Bﬂ:k * i) ? p ! Search :,:_' Folders E m m D
A

mEX]

Address

Folders

|_-_:} Desktop
# L) My Doouments
& 3 My Compiter
& & My Network Places
& Recyce Bin
& 1% Bluetooth Irformation Exchanger
I+ % File: Transfer
%y Image Transfer
B % Obpect Push

File Transfer Image Cbject Push
Transfer

3. Double-click on the [File transfer] icon.

A list of devices will appear in the [File transfer] window.
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55 File Transfer E@J
Fla ew Favortes Tools Buetooth  Help T
@ Back - d ‘y P, Search | Folders EI Ej E D

% Bluetooth Information Excha'bgar'LFﬂe Transfar ﬂ Lete]
Shared Folder PC-1 POA-1 FOA-2

Note

- If the desired device does not appear in the list, please confirm that the device has
been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

- You can also use "Image transfer" when sending individual image files.

4. Use the mouse to drag and drop the file you wish to send over the destination
icon.
In this case, the file will be sent to a PC named "PC-1".

B3 Fite Transfor

@Ba:k' =3 ) ¥ o~ Search || = Folders ElClEl

B B [

Shared Folder pcz POM-1

B E

FlE-IBE  Fle-zbt
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Note
- When using "File transfer", you can send individual files as well as entire folders.

5. Confirm that the file is being sent.
The file will be sent to the PC.

Note

- When sending files using "File transfer", a message requesting permission to
receive the files may appear on the destination (receiving) device. The content of
the message will vary with the Bluetooth software installed on the destination
device, so please be sure to follow the instructions provided.

If you are using the Bluetooth Utility, a message similar to the one below will
appear.

File Receive Confirmation

Do wou allow a Conniect Begueast from 00:03:2F04:BAF3Y

Save Folder
CADacurnents and Setlings A dminsrstorhly Documen:

Eoook 4 [ .Cancal ]

If the file has been sent successfully, the message below will appear.
Please click on the [OK] button.

Bluetooth &3

-
\‘!f) File transfer was suocesshul,

The message below will appear if the file transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

(Bueton 3

| l"'_x Sending of fle faled. |
Il {

Note

- Files that have been sent will be saved in a file transfer shared folder on the
destination device.
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Additionally, with "File transfer", you can open the shared folder on the destination
device using Explorer, specify a subfolder, and then send the file there.

Lt Personal c_.l[l;ﬂ
Fle ‘Weow Favoribes Tools  Bustooth  Help H
@Bﬁk * &d ? P Search Il:._' Folders El m m lj

Folders » . -

|_-,;} I?lvasktu:-p " _t =

& =) My Doouments
B § My Computer
+ l.,] My Network Places
2 RecycleEin
= ¥ Eluetooth Information Exchanger
= B Fle Transfer
% B} shared Folder
= & pou-
¥ ) Business
= ‘- Personal
# (1 Folder-1
® ] Templakes
%4 Image Transfer
# O object Push

Folder-1 File-1.txt

W

You can use Properties in the Bluetooth Information Exchanger to change the
location of the "Shared folder" on the hard drive.

Receiving files from a PC or PDA

Your PC is able to receive files that have been saved in the shared folder on the destination
PC or PDA. Received files will be saved in the shared folder under "File transfer".
1. Turn on the PC or PDA.

Confirm that a Bluetooth connection has been enabled before proceeding.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

{{{-ﬂ‘&

Note

Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.
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Folders

Fle  WYew Favorbes  Tools  Bluetooth  Help

GMuJmeﬁmm@_--

@' Decktop
& (7} My Documents
& % My Computer
& & My Network Flaces
& RecydeBin
= Y% Elustookh Information Exchanges
# B3 File Transfer
= ?g Image Transfer
# G obgect push

B 5 @

File Trarsfer Image Object Push
Transfar

3. Double-click on the [File transfer] icon

A list of devices will appear in the [File transfer] window.

@Bﬂzﬁ - J I’. J:‘Fi-umth .,'._:'_'

Folders

EEEE

Address 5% Blustooth Information Ex,chan;tar'l,Flu Transfer

BB

PE'H'-I

In this case, the file will be received from the PDA named "My Mobile".
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4. Double-click on the [PDA-1] icon
The file saved in the shared folder in "My Mobile" will appear.

5. Right-click on the file you wish to receive, and then select "Receive file".

e

r

ZdPersonal ;'EI;I:]
Fle Wiew Faworites Tools  Blustooth  Help ";"
@Baa:k T s ? P Search Folders m E E |:|
Falder-1 Fh-lh:l
Delebe |

The file will be received from a PDA.

Note

- With "File transfer", you can send individual files as well as entire folders.
Please right-click on the folder you wish to receive, and select "Receive folder".

Q- Q) - ¥ J

| |

Falder-1 Fie-1.txk
Open

Explarer

Subsequent operations should be performed in the same manner as when receiving
individual files.

If the file has been received successfully, the message below will appear.
Please click on the [OK] button.
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Bluetoath ﬁ

[ = :
“‘!i) Fila transfer was successiul, |

The message below will appear if the file transmission was unsuccessful. Please click
on the [OK] button to close the message, and repeat the procedure.

Bluetooth &3

| "_n. Sending of fils Failed.
L

Note

- The received file will be saved in the "Shared folder" under "File transfer" in the
Bluetooth Information Exchanger

=y ﬁhnred Folder __-.-:.'L_]
Fila Edbt Mew Favorkes Toods Help i

@Emk > gl ‘? 7 ! Search |1 Foldess [II'

Fobders % :
# (L) My Domments b | ,il Folder-1
+ \J My Computer ool

& &4ty Network Flaces [
2l Rocyce Bin FIIBEIJ‘I‘II:'
= ¥[% Blustooth Information Exchanger | L s

y
= % File Transfer i
IE Shared Folder i;_'_.: E'_I_B-.l-'nft_

¥ ™ pop =] 1
= W ppa-1
¥ 8 posez
H E,:- Image Transfer
+ B8 obiect Push wl (g Y

You can use Properties under the Bluetooth Information Exchanger to specify the
location of the "Shared folder" on the hard drive.

Sending images to a mobile telephone
1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.
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{fim)

Note
- The mobile telephone must support the BIP profile.

- The image file”’(*.bmp)(*.jpg,*.jpeg)(*.png)” formats can be sent and received using
"Image transfer".

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

- e
f Bluetooth Information Exchanger L:.,',...EDJ
Fle ‘iew Favortes Joos  Blustocth  Help o
Oﬂmk - ? F ! Search Ii-|_:" Folders El E D Addeess
Felders * % % %
f;—_:} Desktop
@ {7} My Documents File Trarsfer Image Cbject Push
& ;'J My Compuber Transfer
=] \3 My Network Flaces
& Recyce Bin

& 1% Bluetooth Irformation Exchanger
I+ % File: Transfer
%y Image Transfer
B % Obpect Push

3. Double-click on the [File transfer] icon.
A list of devices will appear in the [File transfer] window.
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3 File Transfer AR x|
Fla ew Favortes Tools Buetooth  Help aw
Qe - @ - B Pseact [ rtecs | 2 [ [F
I e ———— | R P S O e v] o
SheredFolder PO PDA-1 POAZ

4. Drag and drop the file you wish to send over the destination icon.
In this case, the image will be sent to a mobile telephone named "BT-Phone-1".

r.
.?_.]-lll.---:-' Transter =(lm

@Bﬂ:k il > . ; J'_"Eca;ch [ Folders |E]|E ) [
o :

Image Inbox  BT-Camera-1 BT

The image will be sent.
If the image has been sent successfully, the message below will appear.
Please click on the [OK] button.
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Bluetooth -

. \“il‘) Image transfer was suocesshul.

The message below will appear if the image transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

‘Bluetooth x|

| IE Sending of image failed. |
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Exchanging business card data with a PC or PDA

You can exchange business card data with a Bluetooth-enabled PC or PDA.
Business card data are exchanged using "Object Push" under Bluetooth Information

Exchanger.
Selecting a business card and sending it to a PC or PDA
1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

E|IJ!:'|:I.II_I|:|'|

Ex I:h:lrll]!"r

Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

-~ e
f Bluetooth Information Exchanger L.'..',..ED.]
Efe  Wiew Favoribes  Tools  Buetooth Help 1l
@Bﬂ:k * i) . ] - earch .l:-. Folders D m r-_] n Address
Folders % % %

|_-_:} Desktop
@ {7} My Documents File Tramsfer Image Object Push
& ;3 My Compuber Transfer
& & My Network Places
& Recyce Bin

& 1% Bluetooth Irformation Exchanger
I+ % File: Transfer
%y Image Transfer
B % Obpect Push

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.

71



53 Object Push '2@
"III

Bz ¥ew Favonbes Tools Eustooth Help

Qe - ) (T T seach [ Folders EEDD

= B2 B

Inbo PC-1 PLua-1

Note

- If the desired device does not appear in the list, please confirm that the device has
been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

4. Use the mouse to drag and drop the business card you wish to send over the

destination icon
In this case, the business card will be sent to a PC named "PC-1".

b PC-1 PO-1
=0
-l{.-'
g —l
Rose
Goady sk

Note

- When you try to send a business card, a message requesting permission to
receive the card may appear on the device belonging to the other party (i.e., on
the receiving end). The content of the message will vary with the Bluetooth
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software installed on the destination device, so please be sure to follow the
instructions provided. If you are using the Bluetooth Utility, a message similar to

the one below will appear.

File Receive Confirmation

Do o wank bo receive a Business Cad fuom 0000 Z4cD2:CE77

Save Foldes
C:ADracurnents and Setlings A dminstrstarby Documerk:

Lok i | Cancal |

If the business card has been sent successfully, the message below will appear.
Please click on the [OK] button.

Bluetooth @;
\‘_i') Business Card transfer was successful,

The message below will appear if the business card transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

Bluetooth
! "_-. Sending of Businass Card Falled.

Selecting your personal business card

You can prepare a business card bearing your name and other details such as your
company and telephone numbers, and then send it to another party.

Note

Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.
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Exchanger

Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

'_7Bluetooth Information Exchanger == =<
Fle ‘iew Favortes Joos  Blustocth  Help i
@Bﬂ:k - ? J}j-:ﬁcmth i||_' Folders !Elm E Addeess
Folders * I:% %

f_—;} Desktop : %

# ) sy Dooumenks File Trarsfer  Tmage  Object Push

=] Q My Computer
=] \3 My Network Flaces
& Recyde Bin
& 1% Bluetooth Irformation Exchanger
@ B3 File Transfer
<] }f; Image Transfer
& B object Push

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.
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U5 Object Push Lo
Fe ‘ew Favoribes Tools  Euetocth Help o
Qﬂﬁk ¥ d . 7 p: !Search || Folders E|E| D

Inbox Pi-1 PD-1

Note

If the desired device does not appear in the list, please confirm that the device has
been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

4. Right-click on the destination icon, and then click on [Send business card To].
In this case, your personal business card will be sent to a PC named "PC-1".

(5 Object Push ok
Fle ‘\iew Favoritas Toals  Blustooth  Help ar
@B-u:k - & - Search || Falders EH:' [

EE A Igl
Iniboce p-c'_]_ (a7 |
T
Explarar
Propesty
Dielate
Service Discovery
Siend Business Card To
Receive Partnes's Business Card From
Exchange My Business Card

The business card will be sent.

Note

When you try to send a business card, a message requesting permission to
receive the files may appear on the device belonging to the other party (i.e., on the
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receiving end). The content of the message will vary with the Bluetooth software
installed on the destination device, so please be sure to follow the instructions
provided. If you are using the Bluetooth Utility, a message similar to the one below
will appear.

Bluetooth

‘?/? Wil you allow a Business Card transfer bo 0003 FA:02:09:877

Ty
|
E |
n_:
—
&

- Business cards that have been sent will be saved in the Inbox of the destination
party.

If your business card has been sent successfully, the message below will appear.
Please click on the [OK] button.

Bluetooth @;
\‘_i') Business Card transfer was successful,

The message below will appear if the business card transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

Bluetooth

! "_-. Sending of Businass Card Falled.

Note

- Data that has been sent will be saved in a folder for exchanged business cards on
the destination device.

Receiving a business card from another party
You can prepare a business card bearing your name and other details such as your
company and telephone numbers, and then send it to another party.

Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

1. Turn on the PC or PDA.
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2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

Note
Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

.E} B.Il..l Carar .h.l:nf.n ..... ﬁ .Eic..m.@'. ...................................... E@
Fle  Wew Favorbes  Jools  Buetooth  Help i
Qo - © B O st |fi rokes || 3| [ [ s

. i |
Fobders : B iR [% % [E

[ pesitop ;

# ) sy Dooumenks File Tramsfer Trmage Object Push
Transfer

=] d My Computer
=] \3 My Network Flaces
& Recyde Bin
& 1% Bluetooth Irformation Exchanger
@ B3 File Transfer
<] }f; Image Transfer
& B object Push

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.
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4 Object Push Lok
Fla ‘few Favorbes Tools  Bustosh  Help i
@Bﬁ:k * & . /.'Sean:h | Folders |E|E| D

= M

Inbox P-1

o

PLua-1

Note

If the desired device does not appear in the list, please confirm that the device has
been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

. Right-click on the icon of the party whose card you wish to acquire, and then
click on [Receive business card]

In this case, the business card of the other party will be acquired from a PC named
"PC-1".

(541 Object Push "2ed
Fla ‘Viaw Favoribes Tools  Blustooth  Help o
ek - D - (T P sench [ rodes ||[F5]IE] (
G
fe. Open
Tt P&l Explorer
| Property
Dielate

Service Discovery
| Send Business Card To
Exchange My Business Card

The business card will be received.
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Exchanging business cards
Simultaneously exchange your business card with one belonging to another party.

1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

7 Bluetooth Information Exc hanger

Efie  Wew Favoribes  Tools

Qe - ©

Folders

Bluetooth  Help

T ) seacn :!l_.' rotes || (31|20 (20

SEX]

Address

|_-_:} Desktop
# L) My Doouments
& % My Computer
=] ‘g My Network Flaces
& Recyce Bin
& 1% Bluetooth Irformation Exchanger
I+ % File: Transfer
%y Image Transfer
B % Obpect Push

File Transfer Image Cbject Push
Transfer

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.
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(54 Object Push M= X
1y
o

Bz ¥ew Favonbes Tools Eustooth Help

@Bﬂck" i ? /'Sear:h [~ Folders EDD

= B2 B

Inbo PC-1 PLua-1

Note

- If the desired device does not appear in the list, please confirm that the device has
been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

4. Right-click on the icon of the party with whom you wish to exchange business
cards, and then click on [Object Push].
In this case, the business cards will be exchanged with a PC named "PC-1".

[-% [I.hjact Push Q@1
w

Fii=  Wew Favoribes  Tools  Blustooth  Hel
ek - &) - (T D search [ Foiders uEE‘, (il =]
G ™ N

Inbox PC-1 Tl
Opan

Explorer

Property
Delete
Service Discovery

Semd Business Card To
Receive Partner's Business Card From
Exchange My Business Card

The business card from the party who executed the "Exchange business cards"
command will be sent first.
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Note

When you try to send a business card, a message requesting permission to
receive the files may appear on the device belonging to the other party (i.e., on the
receiving end). The content of the message will vary with the Bluetooth software
installed on the destination device, so please be sure to follow the instructions
provided.

If you are using the Bluetooth Utility, a message similar to the one below will
appear.

File Receive Confirmation

Do o wank bo receive a Business Cad fuom 0000 Z4cD2:CE77

Save Foldes
C:ADracurnents and Setlings A dminstrstarby Documerk:

Lok i | Cancal |
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Synchronizing data with a PDA

When you connect via Bluetooth instead of with a standard cable, you will always be able to
synchronize your data without the hassle of having to connect the cable.

Connecting using ActiveSync
Preparing the PC

1. On the PC, click on [Start]>[All Programs]—>[Microsoft ActiveSync].
The initial ActiveSync set-up window will appear.
It is assumed in the explanation below that no ActiveSync connections have been
established with other devices.

& Microsoft ActiveSync E
Fie Yiew Tools Help ]

Detals

No partnerships
+
Hot connected @

Information Type Status

2. Click [File]>[Connection Settings].

& Microsoft ActiveSync E._] ] 'ﬁ

'Fle View Tools Help

f: !f:. .-:!

b T

| &
Get Connected. ., I
Close L
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The [Connection Settings] window will appear.

3. Place a check next to [Allow serial cable or infrared connection to this COM
port], and then select "COM7".

Connection Settings

ecled by connect your mo ce to b
= Clck, Get Connected bo bile derv bz
’L.ij compLiler,

Shatus: ‘Wating foe device bo connect Get Conneched..

[+ Sllowe zerial cable or infrated connection bo this COM port:
(COMT 1 -]
Stalus:  COM por is not available

[ Alow UISE connection with this deskbop compubes,
Stahes; LUSH iz avalable

[+ Ao petwork [Ethemet] and Remote Access Service (FAS)
zarval connechion with this decklop computer.

Stabe;  Metwork iz avalable

Stalus icon
[+ Show status jcon in Taskbar,

i Ok I Cancal Help

Note

- In the standard set-up, the port is configured to "COM7" (refer to Steps (3) and (4)
under "Preparing the PDA" below). When using a different port, please also
change the port number selected in this window

Preparing the PDA

1. Tap on the Bluetooth icon in the bottom right of the screen.
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Important

The graphic above shows an example of a PDA operating window.

The connection procedure may be different depending on the manufacturer or
model of PDA you use. Please refer to the product instruction manuals for further
details.

The [Bluetooth Settings] window will open.
The message "Connection not registered" will appear if no Bluetooth device has been
registered.

= | A
_:ﬂf__"_'-;f!ﬁll:n-'l-unll'l sett *1Y &7 € 12:01

| Blustooth Settings

Connection registration
& could nat be perfarmed.
Before establishing a
Bluetoath cornection,
selact the service to which
you want to connact and
regster the connectian,

This message s displayed at the
tire of startug,

=

Tools View Options O, =)

Londl

Please tap on [OK] to close the message.
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2. Double click on [Tools]>[Search for peripheral components].

£33 |Bluetooth sett ‘P & 4< 12:06 (D

Femote Devices Status

Service Mame | Status Diescription

Device Search

Search Options 4

Delete Ghost Devices...
Tools| Yiew Options Q El*
I !

The application searches for nearby Bluetooth devices.
3. Tap and hold on the destination PC icon, and then select [Update Services].

{7 |Bluetooth Sett *1* &F oS 12:11 D |

PL-1

Service Name | Status | Description

|Tools ¥iew Options 1, EI-‘-

A search for services will be carried out, and then a list of service names and their
connection status will appear as list in the lower window.
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Service Mame | Status I Description

Pl COM7 Mot C...  SerialPort(T..,
Filz Trans... Mot C... OBEX File Tr...
Ohject P... Mot C... OBEX Chiec...

Tools ¥iew Options q El‘

Tap and hold on "COM7" from the list of service names, and then select

4.
"Register ActiveSync".

£17 |Bluetooth Sett *19 2t o2 1215 (DY

Service Mame | Status Diescription

b =
IFie T
: Connection Registration
[ ohjec : o
Properties

Tools ¥iew Options C{ E|‘

5. Tap [OK] in the confirmation message window.
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f:; Bluetooth Sett “P" &F < 12:13 @

ync Auto Connect

Beginning ActiveSync Auto
Connect, Touse a
function other than
ActiveSync auto Connect,
cancel this setting,

(0] 4 Cancel

5 =500 o )
R COM7 Mot C...  SerialPart(T...
BE3File Trans... Mot C... OBEX File Tr...

ﬁ'ﬂDbjEEt P... MotC.  OBEX Objec...

L=

Tools ¥iew Options q, E|‘

An ActiveSync connection will be initiated.

Establishing a partnership between ActiveSync and a PDA

Once a connection has been successfully established with a PDA, the procedure for
establishing a partnership with the PDA will be started by the ActiveSync application on the
PC.

Performing this set-up procedure will enable data to be synchronised between your PC and
PDA.

1. In the [New Partnership (Set Up a Partnership)] window, select "Standard

partnership”, and then click on the [Next] button.
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Hew Partnership @

Set Up a Partnership

Thig wizatd helps pow establish a patneship between pou
mobile device and this computes. Youw can set up ethes a
shtaredand partnedzhip 1o synchiorze data betwesn pour
device and this compuber. of 4 guest paitnership bo senpl
tranzfer data betwean your device and this compuber.

What kind af partnesship would vou like to eztablsh between
wour device and this compubes?

* [Stardard panesshig

| wearit ko syncheonize data babaeen my dewice and
this computer, keeping data such as e-mail and
calendar items updo-date in both places.

™ Guest partnesship

| weart ko arle copy and move infaimation bebween my
desvice and thiz computes, add and remove programs,
of reslole & backup mage on a device whose memony
his been reset. | do not weant fo synchronze data.

Mest > Cacel | Hep |

The [New Partnership (Specify Data Synchronisation Method)] window will appear.

2. Select "Synchronise with this PC", and then click on the [Next] button.

Hew Partnership E
Specify how to spnchronize data -
Choose to syncheorize with yow desklop andfor a saner %ﬁ

W=

You can synchronize data, such as e-mal messages and calendas items, betbwesn pour
diewice and this dezklop computer. However, i you have access to a Mictosoft Exchangs
Server with Exchange AchiveSpnc, vou can also choose some infoemation lypes to
symchionze direcHy with a sarver, getting the most up-to-date infomahion, esvean when pour
deskiop computer i lumed off

Hewi dio pau want bo spnchionize with pour device?
 [Bymceorize with this deskiop compuled
™ Syncheorize with Micsoscét Exchangs Server and/or this deskbop computer

[Mobe; Your must have access 1o Miciosolt Exchange Server with Exchange ActveSync
of Miciozoft Mobde Information Sener.]

¢ Back Blest > Cancel | Help |

The [New Partnership (Select Synchronisation Settings)] window will appear.

3. Select the type of information to be synchronised between your PC and PDA,
and then click on the [Next] button.
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Hew Partnership

Select Spnchionization Setling: -r'h
Selact the type of informnation you want bo synchronize M

To smchionze a parhicudar bype of information, select k= check box To slop
spnchanization of thal information, clear it check box

obie Device | Daskiop Compie: [l
R et
v [5) Calendar Micrazoft Dutiook:
¥ [=] Contacts Microsoit Dutlok
= L-:l Fanvontes Intermet Exploner

| (8 Files Swchionzed Files
o ) Ik Microsoft Dutlook

s Mates Microscét Dullock -

T find out more about and to customize what gets synchionzed, chick
on that mhormation pe in the k=t and then chek Sethngs.

¢ Back Best Cancel | Help |

The [New Partnership (Completing Setup)] window will appear.

4. Click on the [Finish] button.

[Nw.r Partnership @

Setup Complete

“fou are now ready to dait exchangng infomation babween
wour mabile device and this computer

Upon esaling this weard, Mictasell ActiveSyne will open and

If your device i a guest, chick Explore on the toolbar and
start exploring vour device,

I your device has a parinership, syncheorization starts.
Plzase wail unbl syncheorizalion is complete before using
youn device,

Chek Firash ba &t his wizaid,

¢ Back Cancel |

When you click on the [Finish] button, ActiveSync will begin to synchronize your
information.

[Confirming changes]
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& Microsoft ActiveSync E = Eﬁ

|l Y Lovk Hep .
EEEEN |

| PDA-1

Looking for changes. .. @

1}
|| - Inoetristion Type: ... | SERMES - oo b e i ]

(Synchronization process)

[Synchronization complete]

r@ Microsoft ActiveSync E m ﬁﬁ
| Eie View Tools Help “
@ © g

Sy Detals Explore Opticns

PDA-1 @

| Connected
|| Synchionzed

Information Type Status

Elcalendar Synchronized
|| F=]cantacts Syfchronized
ET&:&; Synchronized
|| el Faworites Syndhronized
|| (Ehtribes Syrchronized

While the ActiveSync connection is active, synchronization will be performed
whenever information is changed on either the PC or the PDA.

Once a partnership has been established, every time you start your PC (and PDA)
thereafter, a Bluetooth connection will be opened and ActiveSync will synchronize

your information.

Finishing an ActiveSync connection
Tap and hold on "COMY7" in the Bluetooth Settings window, and select [ActiveSync Release].
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Cancelling a partnership

£33 |Bluetooth sett ‘P &t £ 12:20 (D

Service Mame | Status

Description

(Lalal=1

Activesync Release
Connection Registration

Properties

Tools ¥iew Options Q El“

1. Click on [File]>"Delete partnership".
2. Click on the [Yes] button when the confirmation message appears.

|@'Hicmsuﬂ ActiveSync |___._] ; ﬁ

ble ‘iew Tools Help

Mobile Device [

Delats Partnership

Get Connected..,
Conmection Settings. ..

Closa

[Flcalendar
E:|C|:-nta1:t5
Tasks
@Favn@m*;
(3 Inbax
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Fax transmission

Using a modem station for fax transmission

Important

Please refer to the modem station instruction manual for information on how to
connect the station to a telephone line.

Please ensure that any drivers used to connect the PC to the modem have been
installed.

A Bluetooth passkey (PIN code) is required for you to connect to the modem
station. Please make a note of your Bluetooth passkey before you start the set-
up process. Typically, the PIN code is on the Bluetooth device.

A fax application is required for you to be able to send and receive faxes. The
description below is based on a example using Microsoft Fax, which is installed
with Windows XP as standard.

If you are going to use a commercially available fax application, then please
refer to the manual that came with the application for information on how to
send and receive faxes.

Setting up the modem station

1. Turn on the wireless modem station.

2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Note

Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings], and
then click on [New Connection] from the active [Bluetooth Settings] window.

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)]
window will appear.

Bluetooth Settings

Add MNew Conmection
Dienvice Properties

Powser OFF

Ciplions [

Hedp
Exit

Qs +

3. Select [Custom Mode], and then click on the [Next] button.
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Thiz vazard registers the connechon infomation of & remote
davica.
Select the wizard mode.

(") Exprezs Moda [Recommended)
The miost useful zervice on a remobe device iz set up,

(%] Cuztom Mode
An avalable service on a remole device 13 seleched and set

uam][cml]i

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will appear.

";ldd Hew Connection Wizard

Searching for Bluetooth devices.

Seaching for Bluetooth devices.

Once the program has finished searching for the devices, the [Add New
Connection Wizard (Select Device)] window will appear.

4. Select the device name of the wireless modem station from [Device List], and
then click on the [Next] button.
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T GOt Wizard

Select a device

|
Pleazs chooze the Blustooth device you wish bo use. |

Blustooth device

o e
| & [ BT Modsm |
|8 Po-1

| B PocketPs

| £ Blsztooth Printer

[ «Back || News | [ Cancal ]

The [Add New Connection Wizard (Searching for Services)] window will appear.

";ldd Hew Connection Wizard

Pleaze wait while the wizard connects to a remote device.

The local device iz connecling lo the iemote device
ZAMVICE,
Flease wal

5. If you are connecting to the wireless modem station for the first time, enter the

passkey for the device from the [Bluetooth Passkey (PIN Code)] window, and
then click on the [OK] button.
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Bluetooth Manager - Bluetooth Sec urity

B

Blustooth Passkey (PIN}

(IF ledt Blark, the default FIM will be used )

Request Device
Blustooth Devica Address,  D0:0000:00:00;00
Blustooth Device Marmea; TOSHIES BT Modem

[ ook ][ cena ]

Once the program has finished searching for the services, the [Add New

Connection Wizard (Select Service)] window will appear.

6. Select "Fax" under [Select Service], and then click on the [Next] button.

r'hdd Hew Connection Wizard

Select a service.

Please chooze the senace o use.
Service seleciion
Senvice Class Senvice Name
@ Dualup Netwo... Diskup nebwoiking
- iFax Fax
| 2 Senal Port Seral Port

[ <Back || Mews | [ Cancal ]

The [Add New Connection Wizard (Select COM Port)] window will appear.

7. Check [Use default COM port], and then click on the [Next] button.
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r'hdd Hew Connection Wizard

Select a COM port

Set the COM post bo wse.
'Wwie recommend using the defaull COM pot |

Asmgrimant of COM Port Mame

[[sBect J[__tiew> ) [ Comcel ] |

Note

- The modem station will be installed to the grayed-out COM port displayed under
[Assignment of COM Port] in this window. You will be specifying this COM port in
Step (3) of "eInstalling a Modem", so please write it down for future reference.

The [Add New Connection Wizard (Connecting to Remote Device)] window will appear.

ﬂhdd Hew Connection Wizard

Pleaze wait while the wizard connect: to a remote device.

The local device is connecting b the remate device
FaMIcE.

Please wail

The [Add New Connection Wizard (Modem Settings)] and [Phone and Modem Options]
windows will appear.

96



8. Click on the "Add..." button in the [Phone and Modem Options] window.
The [Add New Hardware Wizard (Install New Modem)] window will appear.
Install the modem by following the instructions in the windows that follow.

Phone and Modem Options [.ilﬁ‘
Dhalng Aues | Modems | Advanced
Eﬂb The lobowang modems: are instalad:
Modem Aftached Ta
nsl',S;:lbﬂun e S e
| Add... | | Bemowve | [ Propeities |
[ ok J[ canca ]

Installing a modem
The [Add New Hardware Wizard (Install New Modem)] window will appear.

1. Check [Don't detect my modem; | will select it from a list], and then click on the
[Next] button.

97



hdd Hardware Wizard

Inztall Mew Modem
Do pou want Windows bo deteck wour modem?

‘wihdows wil now by o detect your modem. Before
continiing, you should

1. Ifthe maodem iz attached to pous
compular, make sure § i luned on

2. Cuat arg programs that may be uzng
the modeen,

Chick. Mext when yoas e ready bo conbriue.

b Don'l detect ey modem; | will select i from a kb

[ <Back || Mews> | [ Cancal |

A list of modem manufacturers and models will appear.

2. Select the desired wireless modem from under [Manufacturer] and [Models],
and then click on the [Next] button.

hdd Har dware Wizard

Install Mew Modem

H-‘ Select the mardactue and modsl of yous medem. I your modesn iz not Bsted, o il pou
l!:!‘; hanee an installation disk, chek Have Dk

Marndachumes Modelz

(Standard Modem Types] Eluetooth Modem |
clakaModem ipeel || TR
/&, Thiz diiver iz not digitally signed!

[ <Back |l Mew> | [ Cancal |

Note

- If you have not yet installed a modem driver, click on the "Use Device" button to
install one from this window.
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- If no modem drivers appear, please select "(Standard Modem Types)" and
"Standard 33600 bps modem."

Add Hardware Wizard

Install Mew Modem e
oy

Select the manulactiner and model of yous modam, [ wour modeem iz nol Bsbed, o il wou
harve an inztallabon disk, chck Have Disk.

Marufachuer . Modals o
[Standard Modem Types| 5ok Standard 13200 bpe Madern
5 Standard 28800 bps Modem
S Shandard 33600 bps Maden |
55 Standard 55000 bps Modem -
S This diveris dgitaly signed.
| <Back J| Mew> | [ Cancal |

A window will appear where you can specify the port to which you can install the modem.

3. Select "Selected Port", specify the COM port to which the modem will be
installed, and then click on the [Next] button.

Ahdd Hardware Wizard

Inztall Mew Modem
Select the portfs] wou want bo instal the modem on.

‘foiui have zelected the folowing madenm:
| Blustooth Modem

Or which ports do you want to install it?

Al pottz
i Sedacted poits

[ com
| coms
|_COM7
!.mm T |

|

| <Back || Mew> | [ Cancal |

Important
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Please specify the COM port displayed in the window pertaining to Step (7) under
"eSetting up the modem station."

4. Click on the [Continue] button.
The wizard will display the following window by design, but you may disregard it and
click on the "Continue" button.

Har dware Installation

' E The soitwale you are mstaling for this hardware:
-
Bhuztoatih Madem

haz not passad Wu‘duws Ltg:rtssllng 1|:l v‘sul:..' ] cu:umpallbdlu.'
with Windows =P, 12 : ]

Continuing youwr installation of thiz zoftware may impair
or destabilize the comrect operation of pour system
aither immediately or in the future. Microzolt strongly
recommends that you stop this installalion now and
contact the hardware vendor for zoftware that has
pazsed Windows Logo lesting.

[ Continue Anpweay | [ETDPInslaJlatn:m ]

A window will appear indicating that the modem installation is complete.

5. Click on the [Finish] button.

Add Hardware Wizard

Inztall New Modem
Modanm nstallzbion iz finiched!

‘four modem has baen set up successiully.

IF you want 1o change these sefings, double-chck the
Phone and Modem Dptions icon w Control Panel, click the
Modems tab, select this modem, and then cick, Properies
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6. Confirm that the configured modem has been added to the list in the [Phone
and Modem Options] window, and then click on the [OK] button.

Phone and Modem Options F[_ﬂﬁ
Dislng Fules | Modems | Advanced
| E : The fokowang modems are instalad:
(PBuetoohModem  COMAD
=9 Solbware Modem AMA COMz
[ ok J[ canca ]

The [Next] button will be enabled on the [Add New Connection Wizard (Modem
Settings)] window.

7. Click on the [Next] button on the [Add New Connection Wizard (Modem
Settings)] window.
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r'hdd Haw Connection Wizard

Maodem zetting

Chck Nest alter the modem configuration & complele.

[ <Back || Newts | [ Cancal ]

The [Add New Connection Wizard (Connection Name Settings)] window will appear.

8. Enter the type and name of the icon displayed after registration, and then click
on the [Next] button.
Please click on the [Next] button if you are satisfied with the settings.

r'.Uaml Hew Connection Wizard

Enter a name and zelect an icon.

Setup the cormechon name and icon.

Sethng infomnation
Cornection Names:
i

== I | Change lcons...

[ | Create a ghartcat an the deskiop

| <Back || New> | | Cancal ]

The [Add New Connection Wizard (Completing the Add New Connection Wizard)]
window will appear.
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9. Click on the [Finish] button.
The settings will be registered, and the icon will appear in the [Bluetooth Settings]

window.
=

i

Setting fax information
Configure send/receive settings and register fax information.
1. Select [Start]>[Control Panel], and then double-click on the [Printers and Other
Hardware] icon.
Note

- If the control panel is displayed in "Classic view", and you use Windows 2000,
please start from Step (2).

2. Double-click on the [Printers and Faxes] icon.
The [Printers & Faxes] window will appear.

3. Click on "Install a local fax printer" in the [Printers and Faxes] window.
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A window showing installed programs will appear, and a Fax icon will have been
created in the [Printers and Faxes] screen.

4. Click on "Send a fax" under "Printer Tasks" on the left side of the window.

104



-2 Printers and Faxes 'J:-_:[;I:-I_.]

e

Fla Edt Yew Favorkes Took Help F

Ll
’;.r 7 Search |- Folders r_':'"ﬂ'

Printer Tasks
[E] Add & printes
&) Send & Fax

See Also £

7] Troubleshoot printing
k) Get help with printing

¥

Other Places

[ conitrol Pane!

'y Scanners and Cameras
(L) My Decuments

ill My Pickures

J My Computer

Details =

If you have not yet configured a fax device, the [Fax Configuration Wizard] window will
appear. In the window you can enter settings pertaining to the sender (yourself).

Note

- If the fax configuration information has already been registered, the [Send Fax
Wizard] window, which can be viewed under "Sending a fax" below, will appear
instead of the [Fax Configuration Wizard] window.

5. Enter the sender information, and click on the [Next] button
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F'Fa:u: Cunﬁﬁumﬁon Wizard E

Sender Information 7 '
Enter cendar mformation that wil appear on fak cover pages. @'

Yourlylmame:  |RG Ea number: 0207 £34 210

E-mal address;  ci el Rl

Litlec Copanty:
Diffice facation: Departmen:
Horee phore: wionk, phone:
Address:

Biling coda;

IO ey || T ]

Note

- The sender information that you configure here will be automatically appended as
header information when you send a fax.

6. Select a device to be used for fax transmissions, enable the device for sending
or receiving, and then click on the [Next] button

F-Fa:t Configuration Wizard E

Select Device for Sending or Heceiving Fazes &
Select the device that pou want 1o uze bo eend of receve fakes @:

Flease select the fax device

[+] Enabie Send
[ 1 Enabls Receive

[ <Back || Meas | [ Cancel ||

Note
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If [Enable Receive] is selected, the device will be on standby for receiving faxes
even if it is not sending or receiving anything, and therefore will be in continuous
connection to the wireless modem (when COM Auto Connect is on). Please
decide whether to select this option based on the desired objective and/or

frequency of transmission.

7. Click on the [Next] button.
It is important that you do not change the transmitter subscriber identification.

FFax Configuration Wizard ﬁ

Tranzmitting Subscrnber ldentification [TS1D]) {"
Enler the Tranzmiting Subscnber [dentfication [TSI0] bo be wzed bo idenfify pour @r

compuler ha & [ax recipenl

The TSID i transmatted when you send a fax, and usually consists of a
fax number and & business name.

IsID: Fan

| <Back || Mews> | [ Cancal

8. Click on the [Finish] button.
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Fax Configuration Wizard

Wizard

“vous have successfuly completed the Fax Configurabion
‘wizard

g Completing the Fax Configuration

Configuration Summary
Device: configuied bo send fanes:

Blustooth Modem
The TSID of thess davices iz Fax.

To cloze this wizard, chcek Finish.

[ <Back J{_ Fnish | [ Cancal
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Setting fax information
Important

The Fax service must be enabled for sending in order for you to send a fax.
Please refer to "Using a wireless modem station" under "Troubleshooting" for how
to change the send and receive settings once the service has been configured.

1. Double-click on the [Fax] icon in the Control Panel.
The [Fax Console] window will appear.

i Fax Console '.._:[g}ﬁ I

Fie Edt View Took Help

= g Fax 0 Start Time TSID | Caler ID Pages = Skabus Size | CSID

(] Sent Ttems

€ | >
For Help, press Fi 0 Ttems L Ready

2. In the [Fax Console] window, click [File]—>[Send fax].
The [Send Fax Wizard (Starting the Send Fax Wizard)] window will appear.

3. Click on the [Next] button.
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Send Fax Wizard ﬁ

Welcome to the
@ Send Fax Wizard
Thig wazand belps pou create and sand a fa

Tofar a documert, create of apen it m & Windows-based
application, and print ko a fax prirger.

L et » ][ Camcal ]

The [Send Fax Wizard (Recipient Information)] window will appear.

4. Enter the name and fax number of the destination party, and then click on the
[Next] button.

Send Fax Wizard
Recipient Information
Entar the name and number of the pereon pou want to zend the fax to, ry
of chok Address Book to selecl a [ax recipient

To UE Bhueloalk ple Addrezs Book...

Location:

E e number: | ] 0207 654 3210

[ ] Lise disling rbes

To sand bo mulliphs recipeents, ype each recipeent's infoimation above, and then
click Add to add the recipient to the liet balow,

Aecipant name F i rurmbaar Add

[ + Back " Meut » ][ Camcal ]

The [Send Fax Wizard (Preparing the Cover Page)] window will appear.
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5. Specify the cover page template, subject line, and note (body text), and then
click on the [Next] button.

Send Fax Wizard

Praparing the Cover Page
Selact a cover page template, and bype a subgect line and mobe | requited by the ey
template

Thiz mfoemation iz automaticaly added ta the cover page.

Cowver page tamplate: | _ . vi Sendet [nfoimation, .
Subjact fne:
Higel's leaving do :
| ——— |
Hoba:

‘wiell be &t the Dog and Duck in Scha flom 7:30 ormvards
Let mie knoe i your'l be able b make &

| <Back || HNew> | | cancal |

The [Send Fax Wizard (Schedule)] window will appear.

6. If you wish to send the fax immediately, select "Now", and then click on the

[Next] button.
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Send Fax Wizard ﬁ
Schedule
Specify when you want youw Fax to be sent, and set pionky =
Higher peionty fawes will be senl fis)

‘wihe do you want to send this fae?
(@ ifow

() When discount rates apply

() Spectic fime in the nest 24 hours

‘wihat iz the fas priciily?
() High

(%) Homal

O Low

[ < Back " et » ][ Camcal ]

The [Send Fax Wizard (Completing the Send Fax Wizard)] window will appear.

7. Confirm the destination information and transmission details, and then click on
the [Finish] button.

Send Fax Wizard ﬁ
Completing the Send Fax

wizard
‘fou have successhdly created a fax as follows:

From:
Recipierd nams Fax rwmber
UK Blugtaath ple 0207 654 3210

Cover page template; fi
Subject Migef's leaving do
Timez to send Mo

[ Erawiew Fax ... |

To send waur lax, click Finish

| <Back || Finsh ] [ Cancal |

The software will automatically dial the number and send the fax.
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" Fax Monitor

=
S8

Sendng page 1 of 1

The hme elapsed is 0132

Sendng fz= 1o UK Bluetoeth ple

[+] Kz thiz dialog vizible at 2 tmes

I Hida ||_Eiammd l Maoga 3 i

Once the fax has been sent, Fax Monitor will revert to standby mode.

" Fax Monitor =]
Feady

[“]keep this dislog visible at al tmes

I Hida | Anzwar now | Maora I

Receiving a fax

1. When a fax arrives, the Fax Monitor will start automatically as the fax is
received.

"f;l Fax Monitor ww

S &

The cal was answered

The time elapsed is 008
Rieceiving fa

[+] K eep thiz dialog visible at &l bmes

l Hida ] L_ﬂiammd | l Moda »» ]

Once the fax has been received, the Fax Monitor will revert to standby mode.
Note

- If you have enabled manual fax reception, the message below will appear when a
fax arrives.

) The fine is ringing Ly
Click bere: to answer this call as a Fax call,

TN R RRWA 1 s

Click on the message with your mouse to receive the fax.
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2. Double-click on the [Fax] icon in the Control Panel.
The [Fax Console] window will appear.

3.

In the [Fax Console] window, double-click on the fax that has arrived.

& Fax Console S

Be bk dew fooh M0

il e@EE s E D e : hein :

= s Fax (| Stark Time: TSI | Caller ID Pages | Status See | CSID
3 Inconing (& iejinjzo0a 08t . | Success  20KB Fax |
{20 Inbax
3 Outhios:
(B Sent Ttems

For Help, press F1 1 Item 5o Ready
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Using a mobile telephone for fax transmission

Important

- Please ensure that any drivers used to connect the PC to the mobile telephone
have been installed.

- Bluetooth passkey (PIN code) is required for you to connect to the mobile
telephone. Please make a note of your Bluetooth passkey before you start the
set-up process. Typically, the PIN code is on the Bluetooth device.

- A fax application is required for you to be able to send and receive faxes. The

description below is based on a example using Microsoft Fax, which is installed
with Windows XP as standard.

Setting up the mobile telephone
1. Turn on the mobile telephone, and set it to be connectable via Bluetooth.

2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add MNew Connection
Dievice Properties

Powveer OFF

Ciphions ]

Hedp
Exit

= s . Qs

Note

- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings], and
then click on [New Connection] from the active [Bluetooth Settings] window.

- The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)]
window will appear.

3. Select [Custom Mode], and then click on the [Next] button.
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Thiz vazard registers the connechon infomation of & remote
davica.
Select the wizard mode.

(") Exprezs Moda [Recommended)
The miost useful zervice on a remobe device iz set up,

(%] Cuztom Mode
An avalable service on a remole device 13 seleched and set

uam][cml]i

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will appear.

";ldd Hew Connection Wizard

Searching for Bluetooth devices.

Seaching for Bluetooth devices.

Once the program has finished searching for the devices, the [Add New
Connection Wizard (Select Device)] window will appear.

4. Select the device name of the mobile telephone from [Device List], and then
click on the [Next] button.
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T GOt Wizard

Select a device

|
Pleazs chooze the Blustooth device you wish bo use. |

Blustooth device

o e
| & [ BT Modsm |
|8 Po-1

| B PocketPs

| £ Blsztooth Printer

[ «Back || News | [ Cancal ]

The [Add New Connection Wizard (Searching for Services)] window will appear.

";ldd Hew Connection Wizard

Pleaze wait while the wizard connects to a remote device.

The local device iz connecling lo the iemote device
ZAMVICE,
Flease wal

5. If you are connecting to the mobile telephone for the first time, enter the

passkey for the device from the [Bluetooth Passkey (PIN Code)] window, and
then click on the [OK] button.
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Bluetooth Manager - Bluetooth Sec urity

B

Blustooth Passkey (PIN}

(IF ledt Blark, the default FIM will be used )

Request Device
Blustooth Devica Address,  D0:0000:00:00;00
Blustooth Device Marmea; TOSHIES BT Modem

[ ook ][ cena ]

Once the program has finished searching for the services, the [Add New

Connection Wizard (Select Service)] window will appear.

6. Select "Fax" under [Select Service], and then click on the [Next] button.

r'hdd Hew Connection Wizard

Select a service.

Please chooze the senace o use.
Service seleciion
Senvice Class Senvice Name
@ Dualup Netwo... Diskup nebwoiking
- iFax Fax
| 2 Senal Port Seral Port

[ <Back || Mews | [ Cancal ]

The [Add New Connection Wizard (Select COM Port)] window will appear.

7. Check [Use default COM port], and then click on the [Next] button.
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r'hdd Hew Connection Wizard

Select a COM port

Set the COM post bo wse.
'Wwie recommend using the defaull COM pot |

Aesigrimant of COM Part Mame

[[sBect J[__tiew> ) [ Comcel ] |

Note

- The mobile telephone will be installed to the grayed-out COM port displayed under
[Assignment of COM Port] in this window. You will be specifying this COM port in
Step (3) of "eInstalling a Modem", so please write it down for future reference.

The [Add New Connection Wizard (Connecting to Remote Device)] window will
appear.

"ﬁdd Hew Connection Wizard

Pleaze wait while the wizard connect: to a remote device.

The local device iz connecling la the iemote device
ZAVICE,
Pleaze wail
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The [Add New Connection Wizard (Modem Settings)] and [Phone and Modem Options]
windows will appear.

8. Click on the "Add..." button in the [Phone and Modem Options] window.
The [Add New Hardware Wizard (Install New Modem)] window will appear.
Install the modem by following the instructions in the windows that follow.

Phone and Modem Options Lﬂ@
Dhalng Aues | Modems | Advanced
h The lobowang modems: are instalad:
EE =,
Muodem _ Aftached Ta
Soltwase Modem MR COM3
| Add... || Bemowve |[ Propeities
ok J[ concet |

Installing a modem
The [Add New Hardware Wizard (Install New Modem)] window will appear.

1. Check [Don't detect my modem; | will select it from a list], and then click on the
[Next] button.
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hdd Hardware Wizard

Inztall Mew Modem
Do pou want Windows bo deteck wour modem?

‘wihdows wil now by o detect your modem. Before
continiing, you should

1. Ifthe maodem iz attached to pous
compular, make sure § i luned on

2. Cuat arg programs that may be uzng
the modeen,

Chick. Mext when yoas e ready bo conbriue.

b Don'l detect ey modem; | will select i from a kb

[ <Back || Mews> | [ Cancal |

A list of modem manufacturers and models will appear.

2. Select the desired mobile telephone from under [Manufacturer] and [Models],
and then click on the [Next] button.

hdd Har dware Wizard

Install Mew Modem

H-‘ Select the mardactue and modsl of yous medem. I your modesn iz not Bsted, o il pou
l!:!‘; hanee an installation disk, chek Have Dk

Marndachumes Modelz

(Standard Modem Types] Eluetooth Modem |
clakaModem ipeel || TR
/&, Thiz diiver iz not digitally signed!

[ <Back |l Mew> | [ Cancal |

Note

- If you have not yet installed a mobile telephone driver, click on the "Use Device"
button to install one from this window.
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- If no mobile telephone drivers appear, please select "(Standard Modem Types)"
and "Standard 33600 bps modem."

Add Hardware Wizard

Install Mew Modem e
oy

Select the manulactiner and model of yous modam, [ wour modeem iz nol Bsbed, o il wou
harve an inztallabon disk, chck Have Disk.

Marufachuer . Modals o
[Standard Modem Types| 5ok Standard 13200 bpe Madern
5 Standard 28800 bps Modem
S Shandard 33600 bps Maden |
55 Standard 55000 bps Modem -
S This diveris dgitaly signed.
| <Back J| Mew> | [ Cancal |

A window will appear where you can specify the port to which you can install the modem.

3. Select "Selected Port", specify the COM port to which the modem will be
installed, and then click on the [Next] button.

Ahdd Hardware Wizard

Inztall Mew Modem
Select the portfs] wou want bo instal the modem on.

‘foiui have zelected the folowing madenm:
| Blustooth Modem

Or which ports do you want to install it?

Al pottz
i Sedacted poits

[ com
| coms
|_COM7
!.mm T |

|

| <Back || Mew> | [ Cancal |

Important
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Please specify the COM port displayed in the window pertaining to Step (7) under
"eSetting up the modem station."

4. Click on the [Continue] button.
The wizard will display the following window by design, but you may disregard it and
click on the "Continue" button.

Har dware Installation

' E The soitwale you are mstaling for this hardware:
-
Bhuztoatih Madem

haz not passad Wu‘duws Ltg:rtssllng 1|:l v‘sul:..' ] cu:umpallbdlu.'
with Windows =P, 12 : ]

Continuing youwr installation of thiz zoftware may impair
or destabilize the comrect operation of pour system
aither immediately or in the future. Microzolt strongly
recommends that you stop this installalion now and
contact the hardware vendor for zoftware that has
pazsed Windows Logo lesting.

[ Continue Anpweay | [ETDPInslaJlatn:m ]

A window will appear indicating that the modem installation is complete.

5. Click on the [Finish] button.

Add Hardware Wizard

Inztall New Modem
Modanm nstallzbion iz finiched!

‘four modem has baen set up successiully.

IF you want 1o change these sefings, double-chck the
Phone and Modem Dptions icon w Control Panel, click the
Modems tab, select this modem, and then cick, Properies
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6. Confirm that the configured modem has been added to the list in the [Phone
and Modem Options] window, and then click on the [OK] button.

Phone and Modem Options F[_ﬂﬁ
Dislng Fules | Modems | Advanced
| E : The fokowang modems are instalad:
(PBuetoohModem  COMAD
=9 Solbware Modem AMA COMz
[ ok J[ canca ]

The [Next] button will be enabled on the [Add New Connection Wizard (Modem
Settings)] window.

7. Click on the [Next] button on the [Add New Connection Wizard (Modem
Settings)] window.
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r'hdd Haw Connection Wizard

Maodem zetting

Chck Nest alter the modem configuration & complele.

[ <Back || Newts | [ Cancal ]

The [Add New Connection Wizard (Connection Name Settings)] window will appear.

8. Enter the type and name of the icon displayed after registration, and then click
on the [Next] button.
Please click on the [Next] button if you are satisfied with the settings.

r'.Uaml Hew Connection Wizard

Enter a name and zelect an icon.

Setup the cormechon name and icon.

Sethng infomnation
Cornection Names:
i

== I | Change lcons...

[ | Create a ghartcat an the deskiop

| <Back || New> | | Cancal ]

The [Add New Connection Wizard (Completing the Add New Connection Wizard)]
window will appear.
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9. Click on the [Finish] button.
The settings will be registered, and the icon will appear in the [Bluetooth Settings]

window.
=

i

Setting fax information
Configure send/receive settings and register fax information.
1. Select [Start]>[Control Panel], and then double-click on the [Printers and Other
Hardware] icon .
Note

- If the control panel is displayed in "Classic view", and you use Windows 2000,
please start from Step (2).

2. Double-click on the [Printers and Faxes] icon.
The [Printers & Faxes] window will appear.

3. Click on "Install a local fax printer" in the [Printers and Faxes] window.
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'g_ Drinters and Faxes .
Ffe Edt Wew Favorkes Tooks  Help a

aB:-:Ir < . {I}Dmm | Fokders '

4. 4

i [2] Add a printer
S Trstall a local Fax printer ll
o ik

I See Also
[7] Treubleshact printing
&) Get help with printing

A window showing installed programs will appear, and a Fax icon will have been
created in the [Printers and Faxes] screen.

SF
ey

4. Click on "Send a fax" under "Printer Tasks" on the left side of the window.
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-2 Printers and Faxes 'J:-_:[;I:-I_.]

e

Fla Edt Yew Favorkes Took Help F

Ll
’;.r 7 Search |- Folders r_':'"ﬂ'

Printer Tasks
[E] Add & printes
&) Send & Fax

See Also £

7] Troubleshoot printing
k) Get help with printing

¥

Other Places

[ conitrol Pane!

'y Scanners and Cameras
(L) My Decuments

ill My Pickures

J My Computer

Details =

If you have not yet configured a fax device, the [Fax Configuration Wizard] window will
appear. In the window you can enter settings pertaining to the sender (yourself).

Note

- If the fax configuration information has already been registered, the [Send Fax
Wizard] window, which can be viewed under "Sending a fax" below, will appear
instead of the [Fax Configuration Wizard] window.

5. Enter the sender information, and click on the [Next] button
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F'Fa:u: Cunﬁﬁumﬁon Wizard E

Sender Information 7 '
Enter cendar mformation that wil appear on fak cover pages. @'

Yourlylmame:  |RG Ea number: 0207 £34 210

E-mal address;  ci el Rl

Litlec Copanty:
Diffice facation: Departmen:
Horee phore: wionk, phone:
Address:

Biling coda;

IO ey || T ]

Note

The sender information that you configure here will be automatically appended as
header information when you send a fax.

Select a device to be used for fax transmissions, enable the device for sending
or receiving, and then click on the [Next] button

F-Fa:t Configuration Wizard E

Select Device for Sending or Heceiving Fazes &
Select the device that pou want 1o uze bo eend of receve fakes @:

Flease select the fax device
Bhuetooh Moden
[+] Enabla Serd

[ 1 Enabls Receive

[ <Back || Meas | [ Cancel ||

Note
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If [Enable Receive] is selected, the device will be on standby for receiving faxes
even if it is not sending or receiving anything, and therefore will be in continuous
connection to the wireless modem (when COM Auto Connect is on). Please
decide whether to select this option based on the desired objective and/or

frequency of transmission.

7. Click on the [Next] button.
It is important that you do not change the transmitter subscriber identification.

FFax Configuration Wizard ﬁ

Tranzmitting Subscrnber ldentification [TS1D]) {"
Enler the Tranzmiting Subscnber [dentfication [TSI0] bo be wzed bo idenfify pour @r

compuler ha & [ax recipenl

The TSID i transmatted when you send a fax, and usually consists of a
fax number and & business name.

IsID: Fan

| <Back || Mews> | [ Cancal

8. Click on the [Finish] button.
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Fax Configuration Wizard

Completing the Fax Configuration
Wizard
“vous have successfuly completed the Fax Configurabion

‘wiizard

Configuration Summary

Device: configuied bo send fanes:
Blustooth Modem
The TSID of thess davices iz Fax.

To cloze this wizard, chcek Finish.

[ < Back JE Finigh Jl Carcal |

Please refer to the same procedure of “Sending a fax” and “receiving a fax” in the “Using a
Modem Station for Transmission” section.

Using a Bluetooth-compatible camera
Connecting the camera
1. Click on [Start ]>[All Programs]—>[Bluetooth]>[Remote Camera].

Note
- In Windows 2000, click on [Start]—[Programs]—[Bluetooth] -[Remote Camera].

| & Bluetooth Settings
] Remoke Camera

E ' User's Guide

G wireless Fils Transfer

The [Remote Camera] window will appear.

2. Turn on the camera, and set it to be connectable via Bluetooth.

Note

- Different cameras are operated in different ways, depending on the manufacturer
and model used. Please refer to the instruction manual for further details on how
to operate your camera.

3. Click on the [Camera Search...] button.
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8| Remote Camera

Bluetooth{B) Help

Blugtooth camsra

Irage da

O s

€3 Bluetooth

The camera will be detected and its icon displayed.

emote Camera

Blsbonth camars

@

BET-camera-1

| 0 chiscts 0.00ME

4. Right-click on the camera icon, and select [Connect].

(1=

BT-camens-]

Connect

Autocornect Oh

Change nams
Properties

I Y T
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The camera will be connected, and images from the camera will appear on-screen.

1]

Bluetooth
Camera

Taking a signal picture

By placing the mouse cursor over the on-screen image, the camera's operating window will
appear.
You can operate the camera from this window.

'ﬁ%rﬁéééi s W

1. Click on the & button in the operating window.
A single image will be captured and sent to the PC.
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“Hmots Camars =] i‘:ﬂ

€3 Bluztonth

il

i
BT-Camera-1

_ld:ue:u DUOGME:
Taking several consecutive frames

1. Click on the button in the operating window.
A succession of images will be captured and sent to the PC.

F] RI.H'I'EIIJB Camera _:__. E‘:ﬂ
[ BusstoothiB)  Hel '

G Bluetootn |

i ohijects DLS5ME

Note
- The remote camera shutter cannot be operated while the camera is connected to
the PC.
- The number of consecutive pictures taken can be set to anywhere between 2 and
16.
2. In the [Remote Camera] window, click on [Bluetooth]—[Properties]>[Consecutive
Image Settings].
3. Click on the [<][>] buttons to select the number of consecutive images to be
captured.
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-

Change number of consecutive i...

amber of images: 3 " | .

E OK_% ICam:l:I j

Note

- Images are not only sent to the PC, but are stored in the camera's on-board
memory as well. Please be aware of the remaining memory capacity when you are
taking a large number of pictures.

- Large file sizes are common for high-resolution images, and may take some time

to be transferred to the PC.
Viewing images saves on your PC

A "Remote Camera" folder will be created in the "Bluetooth” folder under "My Documents”
during initial set-up. A folder bearing the same name as the camera will be created in it, and
images will be saved in this folder.

Click the [Explorer] button in the [Remote Camera] window to display the folder where the
images have been saved.

Note

! Image Inbox

Ele Edt ew Favorkes Tools Help "

@Bﬂ:k * <l ? 7/ Search .!. Folders m" Address

Folders
;_:} Desktop
& (L) My Doouments
= W My Computer
= Se* Local Disk (C:)
= |3 Documents and Settings
= ) Administrator
# ') Appfication Data
& 1) Cookies
# ) Desktop
% ¢ Favorkes
F 1) Lecal Settings
=l I My Documents
= ) Bluetooth

H |0 Image Inbox

1 Inbox

| ) RemoteCaners
B I SharedFoider

) My eBocks
H 2 My Music
H ﬂ My Pictures

F L9 My Recent Documents

# 1) MetHood
# ) PrintHood
# 0 SendTo

& ] Start Menu
) Temglates
H ) WIKDOWS

x

~

- This window is an example showing pictures when [Filmstrip] has been selected
from the [View] menu in Explorer.
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Using a headset to communicate
Registering the headset

1. Right-click on the Bluetooth icon in the tasktray, then click on [Add New
Connection Wizard].

Bluetooth Settings

Add Mew Connection
Dienvice Properties

Powser OFF

Ciplions [

Hedp
Exit

- ¥, IT1 Qs +

Note

- Alternatively, you can click on [Start]>[All Programs]>[Bluetooth]>[Bluetooth
Settings], then click on [New Connection] in the [Bluetooth Settings] screen that
has opened.

- The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)]
screen will appear.

2. Turn the headset power on.
Once you have turned on the headset, set the mode to enable a Bluetooth
connection.

Important

The procedure for operating the headset may differ depending on the manufacturer
and model. Please consult your user guide for a detailed description of how to
operate the unit.

3. Confirm that [Express Mode] has been selected, then click on the [Next] button.
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‘Add New Connection Wizard

Wealcome to the Add Mew Connection Wizard

Thiz vazard registers the connechon infomation of & remote
dawice,
Select the wizard mode.

(%) Exprezs Moda [Recommended)
The most uzeful zervice on a remote device iz set up.

() Custam Mode
An avalable service on a remole device 15 selected and seb

[ Mews | [ Cancal |

The [Add New Connection Wizard (Searching for Bluetooth Devices)] screen will appear.

";ldd Hew Connection Wizard

Searching for Bluetooth devices.

Seaching for Bluetooth devices.

|

Once the device search has been completed, the [Add New Connection Wizard
(Select a Device)] screen will appear.

4. Select the name of the headset device from the list, then click on the [Next]
button.

137



Xdd Naw Connection Wizard

Select a device

Pleass chooze the Bhustooth device you wizh bo use.

Bluetooth device

Drevice Mama

33 Hem

| <Back || Mew> | [ Cancal |

5. Answering with the headset.
If the service has been properly detected, a screen will appear indicating that the
headset is being called, and a tone will accordingly sound in the headset.

Bluetooth Settings |

Calling headzel.
Please press headuet button,

Please press the headset switch.

Important

The procedure for operating the headset may differ depending on the manufacturer
and model. Please consult your user guide for a detailed description of how to
operate the unit.

The [Add New Connection Wizard (Configuring (Connecting to Voice Circuit))] screen will
appear, and device configuration will be performed.

Note

- If you are connecting to the headset for the first time, or if another Bluetooth audio
device (for example, the TOSHIBA Speech Recognizer) has not yet been
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registered, the following [Found New Hardware Wizard] screen will appear, from
which you can proceed to install the driver. If another audio device has already
been registered (i.e., the driver has been installed), you can proceed to Step 9
without having to install the driver.

6. Click on the [Next] button.

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz weizard helps you install sofbwae for
Blustooth Sudio Dewice [WOIM] from TOSHIBA

o) 1 your hardware came with an installation CD
=i ot loppy disk. inzert it now,

WWhat do poue wearit the wizasd bo do?

(%) Inztall the software automatically [Flecommendsd)
(73 Irsshall from & Bt o speciic location [Advanced)

Chek Nest ba conbrue

l Mt |[ Canal ]

The [Install Hardware] screen will appear.

7. Click on the [Continue Anyway] button.
The following screen will appear automatically. You may disregard it and click on the

[Continue Anyway] button.
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Hardware Installation

' E Thie eoitware wou are instaling fior this hardware:
-
Bhestooth gudio Device [WDM] fiom TOSHIBS

haz not passed Wlnd-:lm Ltg:tl:ssllng Il:- veul:,' ks cl:-mpalll:«lty
with Windows XP. [T 1

Continuing youwr inztallation of this software may impair
or destabilize the comrect operation of pour system
either immediately or in the future. Microzolt strongly
recommends that you stop this installalion now and
contact the hardware vendor for zoftware that has
pazsed Windows Logo testing,

[ Cortinue Anpway | | STOF Installation |

The [Add New Connection Wizard (Completing the Found New Hardware Wizard)]
screen, which is the final screen of the installation wizard, will appear.

8. Click on the [Finish] button.

‘Found New Hardware Wizard

Completing the Found New
Hardware Wizard

5

The wazard haz finighed inztaling the softvare for

.@ Bluetooth Sudo Device (WD) fiom TOSHIBA
2/

Chek Firish bo clase the: wizard

|

Once driver installation is complete, the [Add New Connection Wizard (Enter Connection
Name)] will appear.

9. Confirm the information you have entered, and click on the [Next] button.
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Add New Connection Wizard

Enter a name and zelect an icon.

Setup the conmechon name and icon.

Selbng irdomnation
Connection Mame:

H5mM

lcon

9 | Change leons...

[ ] Cieate a shatteut an the deskiop

|_ £ Back ][ Net ][ Camcal ]

The [Add New Connection Wizard (Completing the Add New Connection Wizard)]
screen will appear.

10.Click on the [Finish] button.

The configuration information will be registered, and an icon will be displayed in the
[Bluetooth Settings] screen.

Making a connecting to the headset
You can make a connection to the headset from an icon that has been registered in
[Bluetooth Settings].

Important

Before making a connection to the headset, please check that you have turned on the
headset's power, and it has been enabled for a Bluetooth connection. Please ensure
that the following audio-related applications have been closed before you connect the
headset to your PC.

o Windows Media Player, BeatJam, InterVideo WinDVD and other music/audio
playback software

o Windows Messenger and other e-conferencing software
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o LalLaVoice and other voice-recognition software

If you wish to use these applications, please terminate the headset connection before
you launch them.

1. Right-click on the headset icon, then click on [Connect].

(& Bluetooth Settings SOk
Bheetooth  View Halp

£3 Bluetoath

Delete
Datall, ..

] Create Shorteut on Desktop
8 L Rename

B Change Icons. ..

3 e ]!mm--] % Delata

Connection

i

2. Answer with the headset.

A screen will appear indicating that the headset is being called, and a tone will
accordingly sound in the headset. Please press the headset switch.

‘Bluetooth Settings

Caling headzel.
Plezss paz: headsst bulton,

?

If the connection has been properly established, the icon's appearance will change to
indicate a connected state.
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You may now launch conferencing and voice-recognition software and use the headset.

Disconnecting from the headset
Please follow the steps below to disconnect from the headset.

1. Right-click on the headset icon in the [Bluetooth Settings] screen, then click on
[Disconnect].

i Bluetooth Settings = 0Es
Blostooth  View  Help

£ Bluetooth

Bio

Datal. ..

Create Shorkouk on Deskbop
—_— Rename
Change Ioons. ..

@Hﬂu |udﬂ'm'.] 7% Delete
i Connedtio

i

A message will appear, requesting confirmation that you wish to disconnect. Click on the
[Yes] button. The icon on the [Bluetooth Settings] screen will appear as shown below,
indicating that the device has been disconnected.
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Chapter 5

Making a device undiscoverable to other users

1. Right-click on the Bluetooth icon in the task tray, and then click on
[Device Properties].

Bluctooth Settings

Add Mew Connaction
D Propearties

Pawer OFF

Options [

Help
y Exit
TR

The [Device Properties] window will appear.

2. Select [Non-discoverable mode] in [Discoverability mode] under the
[Mode] tab, and then click on the [OK] button.
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Ul Device properties

Gengral | Moda

Dizcovershilly mode

®) Non-discoversble mode

) Genesl discoverstle mode
Connectability mode

) Non-conrectable mods
(&) Connectatle mods

Painng made

) Mon-paitatle mods

(%) Pairable mode

Secuily mode

Link level erforced securty ™
[] Encryption
\ Defaulk
[ok ][ Cancel | [ sk

Your device will now be undetectable by other users, even when they search for other
devices.

Note

- Other devices are still able to establish connections with your device even if you
have enabled the Non-discoverable mode. Please enable "Non-connectable
mode" if you wish to reject connections from other devices.

Encrypting the content of your transmissions

Since Bluetooth communication is conducted wirelessly, there is always the possibility
that a third party may be able to intercept your transmissions.

You can use encryption to render the content indecipherable to anyone who manages
to intercept it.

Important

Encrypting your transmissions will still not guarantee complete security.
Accordingly, please be aware that transmitting data is conducted with an element of
risk for the user.

1. Right-click on the Bluetooth icon in the task tray, and then click on
[Device Properties].
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Bluctooth Settings

Add Mew Connaction
D Propearties

Pawer OFF

Options [

Help
Exit

The [Device Properties] window will appear.

2. Select [Link Level Enforced Security] in [Security Mode] under the [Mode]
tab, put a check next to [Encryption], and then click on the [OK] button.

| Device properties

Discaverasbiby mode

() Non-dizcovarable mode
(&) General discoverabls mods
Conneclabiity mods

(") Non-connectable modi
{%) Connectatle mods

Pasiing made
{3 Morvpairable mode

(&) Pairable mode

Secunly made

Lirk level enfoiced secunty ]
[¥] Encryption
ox [ Concel ][ somy |

Note

- Once you have configured the security mode, a window will appear when
you first make a connection to another device, prompting you to enter a
Bluetooth passkey (PIN code). Please click on the [OK] button after you
have entered the passkey.

146



Bluetooth Manager - Eluﬂmth Security

Eluetooth Passkey [PIN} I
‘%]El {1 eft blank, the defoult PIN vl be used )
Request Device
Elustooth Device Addiezs: 0003748020367
Eluetooth Device Mams: PC-1

[ ok ][ concs ]

The window in which you enter the passkey will not appear once you have connected
more than two times to the device.

Changing the default connection

The "default connection" refers to the dial-up connection configured for use whenever
a connection is made to the Internet.

If several connections have been registered, you can change the default connection by
following the procedure below.

1. Start Internet Explorer.

2. Click on [Tools]—[Internet Options...].

LU e e, L ﬁi.l'ﬂ.! L]
Tools: Help
Mad and News ]

Synchrorize..,
Windows Updake

Show Related Links

The [Internet Options] window will appear.

3. Click on the [Connections] tab.
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| Goosa | Secutp| Prvecy | Coment] Gorrecsoms |Prograns | Advacced]

-, Tosetup an Intemat connection, chck
=] senp.

Dsal-up and Virual Prvate Metwork setings

5 s Camsion O )
| Loewdon A f

[ Resove
Chooge Sattings if you need to configure & prooy eblings...
server For a conneckion.
(%) Neves dial a conneclion

() Dial whenever a network connection is not prazert
() lwgrs: chial my defaull connection

Local drea Metwork [L&N ] sellings

LAN Settings do not apply Lo dis-up connections. Salfings...
Chicose Sattings above For dial-up settings, LA

[ ok J[ conce |[ spow |

In this window, "Direct Connection" is set as the default, and "Never dial a
connection" has been selected.

Change the settings so that "London A" will always be dialled when you connect to
the Internet.

4. Select "Always dial my default connection”.
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 General | Secuily | Privacy | Contert| Connections | Piogiams | Advanced|

To set up an Inkermeat connection, chck
Sebu. ehup

Dral-up and Virual Prvate Metwork setings

35 Direct Connection [Defauk] agd. |
Hemowe

Choose Sattings if you need to configure & prosey ks
un

sarver For a conl

) Neves dial a conneclion

() Dial whenever a network connection is nat prazert

) Blways dhal my detaull connection

Currant Direct Connection Set Dialaul

Local drea Metwork [L&N ] sellings

LAN Settings do nat epply to digh-up connections. Seltingz...
Chicose Sattings above Foe dial-up settings, Lot

Cooe ) Comen ) Lo )

5. Click on "London A", and then click on the [Set Default] button.
( e ———————————— : i

| Genetal | Secuity | Privacy | Cortert| Conrections | Pragrams | Advanced|

.g To sdll.u:l an Inbernet connection, chck
Dieal-up and Yitual Private Network setlings .

Direct Connection [Defaul) Add..

Lewndon & [_]

Choose Sattings if you need to configure a proeey

server for a connection.

{7 Heves dial a conneclion

() D yshemever a network connechion i nat prezent

(%) Always dial my defalt connection

Current Diirect Connection

Local Area Metwardk [LAN] zeltings

LAN Settings do nat apphy to disl-up connections. Selbings...
Choose Settings above For dial-up settings, b

"London A" has been changed to the default connection.
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1 (2]
Internet Options uﬁ'@

Gereral | Secuily | Privacy | Contert | Connechions | Programs | Advanced

M Tosetup an Intermet connaction, chek
=
=
Lisal-up and Virkual Prevate Network zethpgs

23 Drect Connechan

25 London A [Dfad]|

=

Choose Sattings if you need to configure & proy
sarver for a connection.

) Neves dial a conneclion
) Dial whenever a network connection is not prazert
) Blwiairs dhal mip defaull connection

Currant London &

Local duea Metwork [L&N ] sellings

LAN Settings do not apply to dish-up connections. | | AN Selfings... |
Choose Sathings above For dial-up sattings,

[ ok [ conce |[ ook |

Manually creating a virtual Bluetooth COM port

In order for a PC to connect to and communicate with a Bluetooth device, the
Bluetooth Utility will create a gateway for data to be exchanged between the respective
devices. This gateway is known as a "port" (or "virtual COM port").

Since one virtual COM port will be allocated to each device, trouble-free
communication will still be possible even if several devices are being used.

When you use the Bluetooth Utility, a virtual COM port will be automatically created on
set-up; however, virtual COM ports can be created manually if so needed.

Clients and servers

When Bluetooth communications are performed, there will always be a "client/server"
relationship between the various devices. A "client" is a device that sends certain
requests to another device, while a "server" is a device that provides a service on
receipt of such requests from another device.

For example, when a PC issues a print command to a wireless printer, the PC
functions as the client, while the printer functions as the server.

When a PDA or other device attempts to receive files located on a PC by means of file
transfer protocol, the PC functions as the server, while the PDA functions as the client.

Virtual Bluetooth COM ports can be created both for clients and servers.
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- Bluetooth virtual COM port for a client
Virtual COM port used when your device is the client, and requests are sent to

another device.

- Bluetooth virtual COM port for a server
Virtual COM port used when your device is the server, and requests are received

from another device.

Creating a virtual COM port
1. Click on the [Printers and Other Hardware] icon in the Control Panel.

m g I-.Fm Tosh  Heg
Qs - @ iF Prswn s T
2 Control banet - Pick a category

[ Sesech o Clasric Views

1 =
’i‘ Agprarme e anl Themes ;‘ ¥ mlwry aml Elibwy Hardwarn
o S

terdwerk g Lalprnet Dosnection r  limsr Acuts

i, Tewe, i wimgpadge, aml Begronal

# Iqpliens

The [Printers and Other Hardware] window appears.

2. Double-click on the [Bluetooth Local COM] icon.
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11| Pl ot Lol COM = - e Coekriders

kbl “ Mg
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The main Bluetooth Local COM window will appear.
Note

- Even when the Control Panel appears in Classic view, please simply click on the
[Bluetooth Local COM] icon.

o No such distinction between viewing formats exists in Windows 2000.

3. Click on the [Add...] button.
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Jmﬁ_ltiartmi' tooth Local COM T —— “ﬁ

Exzsting COM Ports:

Puait | Description | Owmes [-'*_1
COM1 Communications Port [COM1T]  Spatem

COM3 Soltware Modam Syitem

COME Tashba BT Por [COME] LocalCOM-Chent

COMT Tashba BT Port [COMT) LocalCOM-Server SenalPort[TOSHIBA
ComM0 Toshiba BT Port [COMI0} Irfoimation Eachanger z
CoMmN Toshiba BT Podt [COMTT] Irformation Exchanger

CoMiz Toghba BT Port [COM1Z) Irdoimation E xchanger

COMI3 Tashba BT Pod [COM13] Infoimation E schange

COMI4  Toskiba BT Port [COM14] Information E schanger

COME Toshiba BT Port [COM15) Irfoimation Eschanger g
COMIE Toghiba BT Port [COMTE] Irdoimation Exchamger

COMI7  Toshba BT Pon|OOMIT) Information Exchanges lae]

ok |

The [Bluetooth Local COM Wizard] window, from where you can create a virtual
COM port, will appear.

il Bluetooth Local COM Setup Wizard Ed
. The Local COM Setup Wizard enables pou bo guickly

and eatily create a Bluetooth virtual COM port o pou

can connect bo remote Bluslooth devices.

Select the desired type of Blustooth vilual COM port.

Types of COM Ports:

{* iCreate a Bhestoolh vitual COM port for & chert

[This creates a Bluetaath vittual COM port that
can connect ba the seivice of a remote device. |

™ Create a Blustooth wirtual COM poat for a server,

[Thiz erestes & Blustoolh vittwsl COM poel that is
feady bo recaive a connection from a remote
Bluetooth device and provide ervice Lo that
device.]

Newt > Cacel |  Hep |

Start from this window when creating Bluetooth virtual COM ports for either servers
or clients.

Deleting a virtual COM port
Note
- You can only delete virtual COM ports created by the Bluetooth Local COM utility.

1. Select the port you wish to delete from the [Bluetooth Local COM] window,
and then click on the [Delete] button.
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Pot | Description | Ovmer ]
COM1 Communications Part [COM1]  Sypatem

COM3 Soltware Modam System

COH oshaba BT Pod [COHA] Locall &

COME Toshba BT Part [COME) LocalZ0M-Client

ComM7? Toshiba BT Por [COMT) LocalZ0M-ServerSenalPor (T OSHI
COMB Toshiba BT Pod [COMB) LocalCOM-Server|SenizlPoi[TOSHI
COMID  Toshiba BT Part [COMID] Infoimation Exchenge!

COM1 Tashba BT Pod [COMT1] Irdtmistion E xchenge

COMI2  Toszhba BT Port [COMIZ] Irdfoimation E schanger i
COM3 Toshiba BT Port [COM13) Irfoimation Exchanger

COMid Toghiba BT Podt [COM14] Irdoimation Exchanger

COMIS  Toshba BT Por [COM13) Inkormation E xchanger [l
i1 1l | 1

asd | Deme [ ok ]

A message will appear asking you to confirm that you wish to delete the port.

2. Click on the [Yes] button.

The port will be deleted.

3. Click on the [OK] button.

Pot | Descrption | Owmes [

COM1 Comasications Pot [COM1]  System

CoM3 Soltware Modam Syztem

COME Tashba BT Por [COME] LocsiCOM-Clent

CoMT Tashba BT Port [COMT) LocalCOM-Served SeralPort[TOSHIB

ComM0 Toshiba BT Port [COMI0} Irfoimation Eachanger z

COMT1 Toshiba BT Podt [COMTT] Irformation Exchanger

COM2 Tothiba BT Port [COM1Z) Irdoimation Exchanger

COMI3  Toshba BT Por [DOM13) Infoimetion E xchanget

CoMi4 Toghibva BT Port (COM14) Infarmation E schanger

COME Toskiba BT Port [COM15) Irfoimation Eschanger g

COMIE  Toskba BT Port [COMIE] Irdaimation E xcharger

COMT7  ToshbaB Pon(COMIT)  Infomation Exchenger vl

= 5 = oy 5]
e | _ox_|
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Chapter 6

General operation of the Bluetooth Utility

Bluetooth Manager

Q: Bluetooth icon does not appear in task tray.

If the Bluetooth icon does not appear in the task tray, Bluetooth Manager will not
be active, which will prevent you from being able to use any of the functions of
the Bluetooth Utility.

Start the utilities as instructed below to enable Bluetooth Manager to start
automatically and allow all functions to be utilized.

Bluetooth Settings

(from Windows XP)

[Start] > [All Programs] > [Bluetooth] > [Bluetooth Settings]
(from Windows 2000)

[Start] > [Programs] > [Bluetooth] > [Bluetooth Settings]

Remote Camera

(from Windows XP)

[Start] > [All Programs] > [Bluetooth] > [Remote Camera]
(from Windows 2000)

[Start] > [Programs] > [Bluetooth] > [Remote Camera]

Wireless File Transfer

(from Windows XP)

[Start] > [All Programs] > [Bluetooth] > [Wireless File Transfer]
(from Windows 2000)

[Start] > [Programs] > [Bluetooth] > [Wireless File Transfer]

Q: Unable to turn on Bluetooth.
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+ If the wireless communication switch on your PC has been turned off, the

message below will appear, and you will not be able to turn the power on from
Bluetooth Manager.

[ Bluetooth Manager

<2 Power could not be supplied to the internal Blustocth modula, ||
{r"} Make sure that the Wireless Commurication Switch is set b O,

Please confirm whether the wireless communication switch has been turned on.

Bluetooth Settings

Q: Clicking on the [New Connection] button brings up the message "Unable to prepare
Bluetooth."

. The wireless communication switch is turned off.
Please switch it on.

Q: Remote device(s) cannot be detected

« The other device(s) may have been set to Non-discoverable mode.
Please check the mode settings on the device.

Q: Services on a remote device are undiscoverable

« The other device may be using a profile that is not supported by the Bluetooth
Utility. Please check the profile being used on the other device.

« The following profiles are compatible with Bluetooth Settings.
DUN, FAX, LAP, SPP, HID, HCRP, FTP, OPP, HSP, PAN and BIP

Devices running profiles other than those above will not be able to be registered
with Bluetooth Settings

Bluetooth Information Exchanger
Q: Bluetooth Information Exchanger icon does not appear on Desktop

« Bluetooth Information Exchanger is not active. Please follow the procedure
below to start the utility.

1. Right-click on the Bluetooth icon in the task tray

2. Click on [Options] > [Enable Bluetooth Information Exchanger], and
then check [Enable Bluetooth Information Exchanger]
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The Bluetooth Information Exchanger icon will appear on the Desktop.

Bluetooth
InFarmmation
Excchanger

Q: Transfer failed when sending a file using the right-click menu.

« FTP or OPP are the sending profiles available when you select a file, right-click
it, and then click on [to Bluetooth] to send it.
If the destination device does not support either of these profiles, you will not be
able to send files using the right-click menu.

File transfer will also be unsuccessful if you use FTP to send a file to a device

that only supports OPP.

In such cases, please click on [Bluetooth] > [Profiles] from [Bluetooth

Information Exchanger], and enter the settings shown under Transfer mode.
Q: Cannot open shared folder on other device with "File Transfer".

« The other device may have a certain security level enforced (Non-connectable
mode etc). Please confirm the security settings of the other device.
Please enter the correct password if you are asked to enter one.

Remote Camera
+ See "Using a camera"

Bluetooth Local COM
Q: Cannot add port

« A maximum of 64 virtual COM ports can be added. You will be unable to add
another port if 64 ports have already been configured.

Using a wireless modem station
Q: Modem station cannot be detected.

- If the modem station is connected to and is being used by another device, the
modem station will be undetectable even if you search for it.

Q: Cannot connect to modem station
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If the modem station is connected to and is being used by another device, no
other device will be able to connect to the modem station.

Q: Bluetooth passkey entry failed

The Bluetooth passkey (PIN code) comprises a sequence of alphanumeric
characters, with the letters able to be rendered in upper and lower case.

If [Caps Lock] is on, the Bluetooth passkey may not be able to be entered
correctly.

Q: Cannot connect to telephone line

Please ensure that the telephone cable is connected from the socket to the
"LINE" terminal on the modem station.

Note

- If the telephone cable has come loose because it has not been fully inserted
into the socket, the resulting poor contact may prevent data from being
transmitted accurately.

- Communication will be impossible if the interior of the cable has been
broken. Please replace the cable with another one.

Please ensure that the two slide switches on the underside of the main unit
have been set to the "NORMAL" and "MODEM" positions respectively.

Q: Cannot connect to the Internet

The telephone number of the connection (i.e., the telephone number for the
access point of your Internet service provider) may not be correct. Please check
the telephone number.

The user ID and/or password for the provider with whom you have signed up
may have been entered incorrectly. Please check the user ID and password.

The default connection may have been configured with different settings. Please
set the connection configured for mobile telephone use as the default
connection.

When you place a call using a company switchboard or other exchange, the
system may require you to enter a "0" before the telephone number itself.
Please check the type of telephone line you are using.

Q: Cannot send or receive faxes

Once you have registered a wireless modem station as your fax server, you will
need to enter the fax settings from the [Printer and Faxes] window in the Control
Panel.
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Please refer to "Using a modem station for fax transmissions" for information on
the configuration procedure.

The telephone number of the fax destination may have been entered incorrectly.
Please check the telephone number.

If the setting under COM Auto Connect Settings has been set to "Off", a
connection will not automatically be established with the modem. Please
connect to the modem manually.

When you place a call using a company switchboard or other exchange, the
system may require you to enter a "0" before the telephone number itself.
Please check the type of telephone line you are using.

The fax service may not have been enabled for sending (or receiving).
Please check the settings by following the procedure below.

1. Open [Printers and Faxes] from the Control Panel, right-click on the
[Fax] icon, and then click on [Properties].

Fax
0
Open

Set 25 Dwfaulk Printer
Prirting Preferences...

Paise Prinking

Sharimg...
Use Prirker Cffine

Create Shortout
Diedate
Rename

Froperties

The [Fax properties] window will appear.

2. Select the [Device] tab, right-click on the modem you wish to use,
and then click on [Properties].
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3. Select the [Send] tab, and then confirm that "Enable device to send"
has been checked.

(oo T T mmmm
i s G |
B Epecity seltings for sending Fases .
[)Enatle device to send :

IsID: Fax

The Trangmilting Subscriber Identilication [TSI0) idertifies you a3 a fax
serache, and iz ranemibed by a davice when you send a fae The TSID
usually consists of afax number, and buginess name,

[+#] Inchude bansar

Mureber of reliies: 3':1'

Eelry altes: 102 mines
Discount rate slait | 00:00 '%

Dizcoumt rabe sfope 0000 :%

[ (K. || Canced I Aoply

4. Select the [Receive] tab, and then confirm that "Enable device to
receive" has been checked (when you wish to receive faxes).
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5. Click on the [OK] button.

Using an access point
Q: Access point cannot be detected.

If the access point is connected to and is being used by another device, the
access point will be undetectable even if you search for it.

Q: Cannot connect to access point.

If the access point is connected to and is being used by another device, no
other device will be able to connect to the access point.

Q: Cannot connect to LAN.

The LAN cable may not be properly connected to the access point. Please
check the connection status.

Note

If the LAN cable has come loose because it has not been fully inserted into
the socket, the resulting poor contact may prevent data from being
transmitted accurately.

Communication will be impossible if the interior of the LAN cable has been
broken. Please replace the cable with another one.

The access point may not have been configured correctly, and may not be able
to maintain the connection to the LAN.
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Please refer to the product instruction manual for information on how to
configure your access point.
Q: Cannot connect to the Internet.

- If you are using a LAN to connect to the Internet, the LAN environment of the
company or location where you are trying to establish the connection may
require you to connect via a proxy server.

Using a mobile telephone
Q: Mobile telephone cannot be detected.

- If the mobile telephone is connected to and is being used by another device, the

mobile telephone will be undetectable even if you search for it.
Q: Cannot connect to mobile telephone.

- If the mobile telephone is connected to and is being used by another device, no

other device will be able to connect to the mobile telephone.
Q: Cannot send images to mobile telephone.

- Please use the appropriate transfer method, according to the profiles supported
by your mobile telephone.

If OPP is supported: right-click on a file to send it

If BIP is supported: use "Image transfer" under Bluetooth Information Exchanger
to send images

Q: Cannot connect to the Internet.

« The telephone number of the connection (i.e., the telephone number for the
access point of your Internet service provider) may not be correct. Please check
the telephone number.

« The user ID and/or password for the provider with whom you have signed up
may have been entered incorrectly. Please check the user ID and password.

« The default connection may have been configured with different settings. Please
set the connection configured for mobile telephone use as the default
connection.

Q: Cannot send or receive faxes.

« Once you have registered a mobile telephone as your fax server, you will need
to enter the fax settings from the [Printer and Faxes] window in the Control
Panel.

Please refer to "Using a modem station for fax transmissions" for information on
the configuration procedure.
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« The telephone number of the fax destination may have been entered incorrectly.
Please check the telephone number.

+ If the setting under COM Auto Connect Settings has been set to "Off", a
connection will not automatically be established with the modem. Please
connect to the mobile telephone manually.

- The fax service may not have been enabled for sending (or receiving).
Please check the settings by following the procedure below.

1. Open [Printers and Faxes] from the Control Panel, right-click on the
[Fax] icon, and then click on [Properties].

Fax

1]
Open
Sat a5 Defaulk Printer
Printing Freferences..,
Paiize Prinking

sharing...
Use Prirker Offine

Creste Shorteut
Dedate
Rename

Properties

The [Fax properties] window will appear.

2. Select the [Device] tab, right-click on the modem you wish to use,
and then click on [Properties] .
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3. Select the [Send] tab, and then confirm that "Enable device to send"
has been checked.
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4. Select the [Receive] tab, and then confirm that "Enable device to
receive" has been checked when you wish to receive faxes).
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5. Click on the [OK] button.

Using a PDA
Q: Cannot make an ActiveSync connection.
« Please confirm that you have installed ActiveSync v3.7 or higher on your PC.

« ActiveSync is installed to COM7 as a default. Please refer to "Synchronizing
data with a PDA" and re-configure your ActiveSync connection.
If a port other than COM7 has been used, please amend the ActiveSync
connection settings accordingly.

Q: Cannot locate a saved file.

+ The type of file sent to your PDA, as well as the profile used to send the file,
may affect where folders saved on your PDA are located.

Examples:

Images transferred to your PDA using "Image transfer" > saved in the "Image
transfer" folder

Images transferred to your PDA using "File transfer" > saved in the "Shared
folder"

Using a camera
Q: Camera cannot be detected.
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- If the camera is connected to and is being used by another device, the camera
will be undetectable even if you search for it.

Q: Cannot connect to camera.

- If the camera is connected to and is being used by another device, no other
device will be able to connect to the camera.

Q: Images from the camera can be displayed, but no pictures can be taken.

« The memory card in the camera may be full.
Please make a backup of all your necessary data on alternative media, then
delete the images from the memory card, and ascertain how much free space
remains.

Q: Camera images do not appear in window.

- The camera may not have been set to remote camera mode (image browse
mode, configuration mode, etc).

Certain cameras will end the Bluetooth connection automatically if you change
the settings in a mode other than remote camera mode. Please re-connect to
the camera when you next wish to use the device in remote camera mode.

Using a Bluetooth Headset
Q: Bluetooth Headset cannot be detected.

- If the Bluetooth Headset is connected to and is being used by another device,
the Bluetooth Headset will be undetectable even if you search for it.

Q: Cannot connect to Bluetooth Headset.

- If the Bluetooth Headset is connected to and is being used by another device,
no other device will be able to connect to the Bluetooth Headset.

« A Bluetooth connection will be impossible if the Bluetooth Headset is connected
to a power adaptor.
Please remove the power adaptor and re-connect.

Q: Sound cuts out/cannot hear anything.

« Using a Bluetooth headset with other Bluetooth devices may cause problems
such as interruptions in sound, reduced transfer speed or failure during file
transfer, and disconnection of the other Bluetooth devices. We strongly
recommend using a Bluetooth headset on its own and not in connection with
other Bluetooth devices.

+ Please confirm that the Bluetooth Headset is being operated correctly (for
example, ensure that the correct mode (audio or communications) mode has
been selected).
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« Please confirm that the voice file or CD is being played back normally on your
PC.

« Please check the volume settings on your Bluetooth Headset and PC.

- If Windows Media Player or another audio-related application is active when you
try to connect your Bluetooth Headset, you may find it impossible to connect
properly to the Bluetooth Headset, or even to use it at all.

Please start such applications after you have connected to the Bluetooth
Headset.

If you need assistance, you should consider contacting the company that sold you the
Bluetooth USB Adapter.

We encourage you to register your product and to notice the many support options
available from Zoom.

- Visit our Web site at www.zoom.com and select Technical Support. From here
you can register your device, contact our technical support experts, use our
intelligent database SmartFacts™™ , and/or get warranty information.

- Call our support office by dialing the US number 561-997-9686 or the UK number
+44 08707200090.
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Appendix A

FCC Warning

Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user's
authority to operate the equipment. Caution: For the purpose of satisfying FCC RF exposure compliance requirements,
antennas should be positioned in such a way that a separation distance of at least 20cm is maintained between the
transmitter's radiating structures and the body of the user or nearby persons.

FCC Part 15 Emissions Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

- Consult the dealer or an experienced radio/TV technician for help.

Department of Commerce End User Statement

This item falls under the jurisdiction of the Department of Commerce, and as such, the requirement set forth in section 740-
17 of the Export Administration Regulation must be complied with. See the following Web sites for more information:

Bureau of Export Administration

http://mww.bxa.doc.gov/DPL/Default.shtm

http://mww.bxa.doc.gov/Entities/
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Code of Federal Regulations
http://www.access.gpo.gov/nara/cfr/index.html

Federal law prohibits the sale or distribution of certain products to certain individuals and organizations. Denied persons or
organizations may not, directly or indirectly, participate in any way in any transaction involving any commodity, software or
technology exported or to be exported from the United States that is subject to Export Administration Regulations. The
above Web sites provide a detailed list of individuals and organizations that have been determined to present an
unacceptable risk of diversion to developing weapons of mass destruction or missiles used to deliver those weapons.

It is recommended that this unit be used with a listed computer.

E Declaration of Conformity

Zoom Technologies, Inc., 207 South Street

Manufacturer Boston, MA 02111 USA / 617-423-1072
www.zoom.com

Brand Bluetooth USB Adapter Class 1

Type Model 4310B

The manufacturer declares under sole responsibility that this equipment is compliant to Directive 1999/5/EC via the
following. This product is CE marked.

EN 60950-1: 2001

IEC 60950-1: 2001 [: 'E
EN 301 489-1 V1.4.1:8/2002
B9/336/EEC —EMC EN 301 489-17 V1.2.1:8/2002

99/5/EC - Radio EN 300 328-1 V1.6.1:2004

The following Notified Body has been consulted in the Conformity Assessment procedure:

73/23/EEC — LVD

Number: 1177 Timco Engineering Inc., 849 NW State Road 45, Newberry, FL 32669

-

Andy Pollock Director, Hardware
Engineering 12 Jan 2006
4310B/TF, Boston, MA, USA

Declaration of Conformity

g Zoom Technologies, Inc., 207 South Street

Manufacturer Boston, MA 02111 USA / 617-423-1072
www.zoom.com

Brand Bluetooth USB Adapter Class 2

Type Model 4320A

The manufacturer declares under sole responsibility that this equipment is compliant to Directive 1999/5/EC via the
following. This product is CE marked.

73/23/EEC - LVD EN 60950-1: 2001 [: G
EN 301 489-1 V1.5.1:2004

89/336/EEC — EMC EN 301 489-17 V1.2.1:2002

99/5/EC - Radio EN 300 328-1 V1.6.1:2004

ﬁ ﬁég /Q Andy Pollock Director, Hardware

<~ = Engineering 12 Jan 2006
4320A/TF, Boston, MA, USA
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Declaration of Conformity

Zoom Technologies, Inc., 207 South Street

Manufacturer Boston, MA 02111 USA / 617-423-1072
www.zoom.com

Brand Bluetooth PC Card

Type Model 4312A

The manufacturer declares under sole responsibility that this equipment is compliant to Directive 1999/5/EC via the
following. This product is CE marked.

73/23/EEC — LVD EN 60950-1:2001

EN 301 489-1 V1.4.1:2002 ( €
89/336/EEC — EMC EN 301 489-17 V1.2.1:2002

99/5/EC - Radio EN 300 328 V1.6.1:2004

7 I Andy Pollock Director, Hardware
ﬁf/&(«[ﬁ:’ Q___q% Engineering / 12 Jan 2006

4312A/TF, Boston, MA, USA

NOTICE

This document contains proprietary information protected by copyright, and this User Guide and any
accompanying hardware, software, firmware, and documentation are copyrighted. No part of this
document may be photocopied or reproduced by mechanical, electronic, or other means in any form.

The manufacturer does not warrant that the hardware will work properly in all environments and
applications, and makes no warranty or representation, either expressed or implied, with respect to the
quality, performance, merchantability, or fitness for a particular purpose of the software or
documentation. The manufacturer reserves the right to make changes to the hardware, software, and
documentation without obligation to notify any person or organization of the revision or change.

All brand and product names are the trademarks of their respective owners.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation.
© Copyright 2006

All rights reserved.

0316-A 27408 ©2006
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